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1 Documentation notes 
These instructions are aimed at administrators and users who are familiar 
with the installation and the operation of the software. Read these operating 
instructions prior to commissioning and be sure to keep them accessible for 
later use. Rittal can accept no liability for damage and operating problems 
resulting from non-compliance with these instructions. 

1.1 Storage of documents  

These instructions and all other applicable documents constitute an integral 
part of the product. They must be given to the administrator. The 
administrator is responsible for the storage of the documents so that they are 
readily available when needed. 

1.2 Symbols used and technical terms  

The signal word classifies the effects of a danger in case of non-observance 
of the safety instructions.  

• Note  
Identification of the situations that can lead to incorrect 
configurations or material damage. 

 
The signal words are shown in the following form in the instructions: 
e.g. 
 

 

Signal word! 

1. Description of the danger and 
its effect  

2. 2. Description of the behaviour 
of the user to prevent danger 
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2 Commissioning RiZone 
RiZone is offered as Appliance and as Software Appliance. The 
Commissioning chapter describes the commissioning of both variants. 

2.1 Commissioning the RiZone Software Appliance 

The commissioning of the Software Appliance requires a hypervisor. The 
format of the virtual hard disk is not the same between platforms. The 
following virtualisation solutions are supported: VM-Ware Server and ESX(i). 
The RiZone Software Appliance requires 4 GB RAM, 80 GB hard disk 
and two CPUs with more than 2 GHz as resources . Because of the large 
dependency between the speed and the availability of the network interface, 
we recommend that the Software Appliance is given its own network card. 
The RiZone Software Appliance is started from the management tool of the 
virtualisation platform. The RiZone GUI is not yet available after booting. 
For a detailed description of integrating the virtual hard disk in the 
virtualisation platform, please consult the virtualisation manufacturer's 
documentation. 

2.2 Commissioning the RiZone Appliance 

The installation is performed in accordance with the hardware 
manufacturer's specifications. After switching on the Appliance, the server 
will boot. The required services start automatically. The system is ready. 

2.3 Commissioning RiZone 

The login to the RiZone server is made with the standard user 
Administrator  and the password  “RiZ0ne!! ” We recommend that you 
change the password after the first login. 
RiZone is supplied with the English keyboard layout. If necessary, change 
the keyboard layout after the first login. 

2.3.1 Server name, work group and domain 

The configuration is made with the Windows Server 2008 R2 or 2012 R2 
operating system. If the computer name is changed from the delivered state, 
a new certificate for RiZone must be created. The certificate is created with 
an additional program. This program is available on the server at 
C:\install_rizone\RittalSSLCfg.exe   
. 
 

 
Fig. 1 Creating a certificate 
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P (upper-case must be specified) selects the creation of a certificate for 
productive operation. Press the Enter key to confirm the selection. This 
creates the certificate. 

2.3.2 Network cards configuration 

The network setting is configured from the Windows Server 2008 R2 or 2012 
R2 server operating system. Customise the network setting to your network 
from Start > Control panel > Network and sharing centre.   
If the  IP address has been changed successfully, the trap receiver for 
all devices monitored with RiZone must be modified manually. 
IPv6 is disabled in the delivered state. 

2.3.3 Configuration of the Fully-Qualified Domain Name (FQDN) 

If necessary, the FQDN is changed from System properties (system) > 
Computer name > Change > More . This configuration is not necessary if 
the RiZone server is a member of a directory service or the NetBios name of 
the RiZone server can be resolved. 

2.3.4 NTP server configuration 

All components of the RiZone installation must be operated synchronously.  
If the RiZone server is a member of a directory service, the NTP server  does 
not need to be configured because the directory service makes this 
information available. 
The NTP server is configured manually in the operating system using the 
Change date/time  function. 

2.3.5 Database backup 

RiZone has its own internal Microsoft SQL Express database. This database 
is compressed and backed up once per day. The operation of RiZone 
requires that the database backups are deleted regularly from the RiZone 
server. The backups should be stored on an external backup medium. The 
retention time must be changed appropriately depending on the customer 
requirements. 
No local backups will be created if RiZone is operated with an external 
database. 
As supplied, RiZone operates with a Microsoft SQL Express edition. The 
size of a single database is limited to 4 GB. 
 

 

Caution! 
Ensure that the databases and drives 
have sufficient free capacity. 
To ensure the reliable operation of RiZone, 
the free storage space on the RiZone 
server must be checked in regular 
intervals. The C:\ drive contains the RiZone 
log files in the \Program 
Files(x86)\Rittal\RiZone folder and the SQL 
server log files in the \Program 
Files\Microsoft SQL 
Server\MSQL10.SQLEXPRESS\MSQL\Log 
folder. 
The D:\ drive provides the storage space 
for the database.  

The E:\ drive is the backup drive for the 
database.  
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Old messages and values (Float, Int, String) are deleted automatically from 
the database after 30 or 90 days. The number of days after which messages 
or values are discarded can be set in the 
%APPDATA%\Rittal\RiZone\Data\MetaData\Configurations\DataDBConfig.xml 
file using the two parameters <DaysAfterMessagesGetDeleted> and 
<DaysAfterValuesGetDeleted> or in the RiZone client via Administration > 
Database . If these parameters are not set, the standard values of 30 days 
for messages and 90 days for variable values will be assumed. Setting the 
parameter to 0 deactivates the automatic deletion. 
 
The database backups are stored on the drive of the SQL instance. 
If RiZone is connected to an external database (MS SQL or Oracle), the 
database backup must be performed there. 

2.3.6 Updating the RiZone Appliance 

If you have completed a service contract, you will receive updates for RiZone 
from our service department (E-mail: service@rittal.com, Tel.: +49 (0) 2772 
505 1855). 
 

3 Installation of the RiZone GUI 
The RiZone GUI is installed locally on the client PC. The minimum 
requirement for the client PC: Windows Vista/7/8, 2 GHz CPU, 4 GB RAM, 
40 MB free hard disk space.   
As prerequisite, the Microsoft .NET Framework 4.0 SP1  must be installed. 
The .Net Framework  is available at the following URL: 
http://www.microsoft.com/download/en/details.aspx?id=17851 
The installation file of the RiZone GUI is located in the C:\install_rizone\ path 
on the RiZone server. The RiZone administrator must make available the 
installation file. 
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3.1 Installing the RiZone GUI 

The RiZone GUI Setup Vx.exe  MSI package must be available on the local 
client PC. A double-click executes the file. 

 
Fig. 2 Installing the RiZone GUI  

 

Click OK to perform the RiZone installation. 
 

 
Fig. 3 Installing the RiZone GUI  

 
The license conditions must be accepted. 
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Fig. 4 Installing the RiZone GUI 

 
The target directory can be changed. The preset target directory is: 
C:\Program Files\Rittal\RiZone\  
Click Install  to continue the installation process. 
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Fig. 5 Installing the RiZone GUI 

 
 

 
Fig. 6 Installing the RiZone GUI 

 
Click Finish  to complete the installation. A link to the RiZone GUI is now 
present on the desktop and a link is available at Programs\Rittal . 
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4 Licensing 
RiZone's licensing concept provides a high flexibility matched to the needs of 
the end user. The licensing is made using the following criteria: 

• The number of IP nodes to be monitored 
• The number of concurrently logged-in users 

 
The input of the license key activates the licensed functions. An unlicensed 
RiZone Appliance has a functionally restricted scope. 
 

Model no. Designation  

7990.206 
7990.306 

RiZone volume license for 25 IP nodes 

7990.208 
7990.308 

RiZone volume license for 100 IP nodes 

  7990.103 
  7990.203 
  7990.303 

RiZone Server Software Appliance 

7990.101 
7990.201 
7990.301 

RiZone Server Appliance 

  
 

4.1 Querying the license status 

The Administration > License  entry displays the customer number, the 
license key, the instance number and all licensed functions. 

4.2 Entering the license key 

The Administration -> License  menu can be used in the dialogue to enter 
a license key. 
The RiZone license key is entered in conjunction with the customer number 
and the instance number. Once the license data has been entered, Check  
must be clicked to check the input. The licensed functions will be shown in 
the license window. 

4.3 Exceeding the licensing for RiZone 

The user adds an additional device from the Discovery. No license check is 
made when the project is created. A check is made only when the project is 
uploaded to the server. 
When the project is uploaded to the server, the following message appears 
in the message window: The number of project nodes exceeds the 
limitation. The project has not been uploaded. 

4.4 Exceeding the licensing of the logged-in clients 

When a user is logged in to RiZone, a check will be made whether sufficient 
client access licenses exist. If the maximum number of licenses is reached, 
the following message will be issued: 
The number of concurrently used clients is exceeded . 
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5 Login mask 
The RiZone server must be registered before the first login to RiZone is 
made. The registration installs a certificate for the encrypted communication 
from the server and the GUI on the client PC. 
 

 

Important! 
The certificate must have been created 
once previously on the server. For 
details, see Section 2.3.1. 

 

5.1 Registering a RiZone server 

Prior to the registration of a RiZone server, it must be guaranteed that the 
server can be accessed from the client PC. The accessibility can be checked 
with the Ping  command from the command line of the operating system. If 
the Ping  command is performed successfully, the registration of the server 
can be performed. 
To register the RiZone server, the RiZone GUI is opened. If a server is 
already registered in the GUI, the server will be shown in the server selection 
box. A server is registered from the Others  menu item. 

 
Fig. 7 Registering a RiZone server 

 
The login mask opens a second window that permits the registration of a 
server. Several servers can be registered. 

 
Fig. 8 Registering a RiZone server 

 
The name of the RiZone server is entered in the Host  input field. If the 
RiZone server cannot be reached, a tooltip will appear when the OK button 
is clicked and an exclamation mark indicates the Host  menu item. 

 
Fig. 9 Registering a RiZone server 
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a message window will open that informs about the download of the 
certificate. This message must be confirmed with Yes. After the confirmation, 
the login mask opens. 

 
Fig. 10 Registering a RiZone server  

5.2 Login process 

The RiZone GUI is started on the client PC. The RiZone login window opens. 
The RiZone server can be selected in the selection box. If no server is 
offered for selection, a RiZone server must be registered (see Section 5.1). 
For the first login to the RiZone server, the user is preassigned with 
RiZoneAdmin. The standard password for the RiZoneAdmin is: RiZ0ne!!  We 
recommend that you change the password before the first login. 

5.3 Changing the password 

The RiZone GUI is started on the client PC. The RiZone GUI login window 
opens. The RiZone server can be selected in the selection box.  
The user's password is changed by clicking the Change  menu item next to 
the Password input field. A second window opens in which the old password 
and the new password (twice) must be entered.  

 
Fig. 11 Changing the password 

 
The password for RiZoneAdmin must be at least seven characters 
(alphanumeric) long and contain a special character and both upper-case 
and lower-case characters. Once the password has been changed 
successfully, the login dialogue opens.  
If an unsafe password has been selected, a message text will appear in the 
window.  

 
Fig. 12 Changing the password 
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5.4 Selecting the GUI language 

The GUI language is selected at the login to RiZone. The selection is made 
from the Select language  menu item. If the GUI language differs from that 
of the operating system, all RiZone message boxes use the language of the 
operating system.  

 
Fig. 13 Selecting the GUI language 
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6 RiZone user interface 
This chapter provides an overview of the most important subareas of the 
RiZone user interface.  
The RiZone user interface has two different modes, the admin mode and the 
view mode. You access admin mode only when you are logged in as user 
with administration rights. The user must be in admin mode to create new 
projects or edit existing projects. In view mode, the current RiZone project 
can be monitored only. Depending on the user rights, components can be 
controlled and device configurations changed from within RiZone. 
 

 
Fig. 14 RiZone user interface  
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1 Drop-down main menu 

2 Toolbar (refer to the toolbar explanation) 

3 Tabs for project trees 

Locations tab: Project tree for the location structure. The components 

are represented in accordance with their physical arrangement. 

Devices tab: Project tree of all SNMP components. The components 

are represented in accordance with their technical arrangement. 

SNMP templates tab: List of all SNMP drivers for devices from third-

parties (MIB browser). Drivers can be created, deleted or edited. 

Group tab: List of all variable groupings.  

4 View window: Variable values and graphical evaluations are shown here. 

If several views are called, it is possible to switch between these using 

the tabs at the top of the View window. 

5 Properties window of the components 

The properties of the components selected in window 2 are displayed. 

6 Status window 

The current status messages appropriate for the currently selected 

action are output here. 

 
 
Toolbar explanation 

1.  New project (active only in admin mode) 
Creates a new local project. To activate the project, it must be 
uploaded to the server. 

2.  Open project (active only in admin mode) 
Opens a project file on a drive and loads it to the client. To activate 
the project, it must be uploaded to the server. 

3.  Save project (active only in admin mode) 
Saves the project currently open in the client to a drive. 

4.  Upload to server (active only in admin mode) 
Uploads the project currently open in the client to the server and 
activates it there immediately. Caution:  The project currently 
present on the server will be overwritten. 

5.  Start project (active only in admin mode) 
The client changes to the view mode and then shows the current 
and historic data collected by the server. The project used here is 
that what was most recently uploaded to the server. 

6.  Download from the server (active only in admin mode) 
Downloads the current project from the server to the client. The 
project on the server remains active. Any changes made previously 
in admin mode will be discarded. 

7.  Discover (active only in admin mode) 
Opens the discover window. 

8.  Configure project (active only in view mode) 
The client changes to admin mode. The project can be edited here 
(discover, add or remove components, create charts, etc.). 
 

 



7 Creating a new project 
 

20 RiZone 
 

  EN 
7 Creating a new project 
To create a new project, the user must be logged in as RiZone administrator. 

7.1 Creating a new project 

To create a new project, first click Project > New project  or click the New 

project   icon, specify a name for the project and confirm by clicking OK. 
The newly-created project now appears on the left-hand side of the RiZone 
window. 
 
For configuring, the existing infrastructure must first be created in a tree 
structure below the project name (root node). 
To do this, select the Locations  tab in the left-hand subwindow. 

Then right-click the Root node   and select the Add  item from the 
opened context menu. Select here the required component from the 
Location, Building, Room, Enclosure Suite and Enclosure infrastructure 
components, assign a meaningful name and a description. After clicking OK 
to confirm, the new component appears below the root node. 
Add additional components similarly until the infrastructure of your data 
centre is represented in the project tree. 
Drag & drop can be used to subsequently assign created components to 
other components. Only logical moves, however, are possible here 
(example: a room cannot be assigned to an enclosure). 
The context menu of the infrastructure components also contains the 
Expand tree  and Collapse tree  items. These items are used to open or 
close the complete tree structure below the selected node. 
Please also note the functions 7.4.2 Copy components and 7.2.1 
Autodiscovery of the SNMP components (multiselect functions), because 
they are very useful for creating a complete project tree. 

7.2 Entering the SNMP components in the network 

After the base project tree has been created, it must be populated with the 
components to be monitored actively. 

7.2.1 Autodiscovery of the SNMP components 

Active Rittal components in the network that support the SNMP protocol can 
be acquired using the Autodiscovery function and then added to the project 
tree. 
 

Select from the Edit > Discovery  drop-down menu or click the  icon in 
the toolbar.  
The discovery window opens. 
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Fig. 15 Discovery 

 
Parameters in the discovery window 
Discovery The Discovery checkbox activates the selected protocol for 

the discovery process. 
Start-IP RiZone begins with the search for Rittal SNMP components 

starting at this IP address. The address fields are empty for 
the first call of the discovery function (or after restarting the 
server services). 

Stop-IP RiZone ends with the search for Rittal SNMP components 
at this IP address. The address fields are empty for the first 
call of the discovery function (or after restarting the server 
services). 

SNMPv1/ 
SNMPv3 

Select whether devices should be discovered and included 
via SNMP v1 or SNMP v3. 

Rittal CMC Select if Rittal devices should be discovered.  
Read/Write Communities must be entered in the following 
two fields.  

Custom 
Device 

If a search should be made for third-party SNMP devices, 
the appropriate read/write communities must be entered in 
the following two fields.  
Please note:  To access SNMP devices from third-parties, 
a driver must have been created previously (“SNMP 
templates” tab). Also refer to Section 7.3. 

SNMPRead 
Community 

Read community that contains the SNMP components 
(default public ). 

SNMPWrite 
Community 

Write community that contains the SNMP components 
(default public ). 
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appropriate read/write communities must be entered in the 
following two fields. 

SNMPRead 
Community 

Read community that contains the SNMP components 
(default public ). 

SNMPWrite 
Community 

Write community that contains the SNMP components 
(default public ). 

 
Once the parameters have been set correctly, click Start  to start the 
automatic discovery function. 
RiZone now searches for active Rittal components in the specified address 
range. A list with the devices supported by the current release can be found 
in the Release Notes for the appropriate current version on 
www.rimatrix5.com (Downloads > Software).  
 
After completion of the discovery (100%), all discovered components will be 
listed under Devices . 
 

 
Fig. 16 Discovery with discovered components 

 

 

Important! 
If for the deployment of two 
communications modules not all 
devices are found during the 
discovery, check the IP address 
ranges that you have set for the 
modules.  
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Click the plus sign in front of a component to show additional 
subcomponents (e.g. sensors). 
From the device list, the components in accordance with their arrangement 
in the data centre can be moved with drag & drop into the Locations  project 
tree. 
 

 

Caution! 
All components must be selected individually. 
For example, the selection of a PU does not 
automatically include the selection of the 
associated connected components. 

 
Multiple components can be selected with multi-select and then moved. The 
order of clicking determines the order of the display in the tree after 
dragging. 
Multi-select functions: 
 

Ctrl + left mouse button Select individual components 
Ctrl + A Select all components 
Shift + left mouse button Mark from the previously selected 

component through to the new component  
Shift + up/down arrow Mark from the previously selected 

component through to the component 
above/below 

Ctrl + Plus (main 
keyboard) 

Expand all components starting at the 
currently selected node 

Ctrl + Minus (main 
keyboard) 

Collapse all components starting at the 
currently selected node 

Left/right arrow Expand/collapse the current node 
* (num block) Expand all subcomponents 
+ (num block) Expand the next level 
- (num block) Collapse everything below the selected 

node 
 
Components already assigned to a tree are marked light-blue in the 
discovery list. 
During the move to the locations tree , the device also appears 
automatically in the devices tree , but not conversely. Components used 
only in the devices tree but not in the locations tree can be transferred to the 
locations tree with the Add to locations  function.  
To do this, right-click the component in the devices tree and then select Add 
to locations . The component will then be added at the end of the project in 
the locations tree from where it can be moved to any position in the project 
with drag & drop. 
The moving of components with drag & drop to another position in the 
locations tree is always possible in admin mode. 
If you want to update a component, perform the discovery of the component 
again and with pressed Alt  key use drag & drop to move the newly 
discovered device to the component already present in the project. Before 
the component is replaced, a prompt is issued whether the names and 
setting values of the old components should be transferred to the new 
component. If the new component serves as replacement for the old 
component, click Yes to confirm the dialogue.  
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button. 
 

 
Fig. 17 Project tree with Rittal components 

 
Fig. 17 shows a project tree for which the discovered components have 
already been added. 
 
Basic configuring is completed once all infrastructure components have been 
acquired and the active SNMP components added. 
The project should now be saved with Project > Save project  or by clicking 

the  icon. 
 
 

 

Note! 
The project can be saved only for the 
selected project tree. 

Before saving a project, a component 
of the devices tree or locations tree 
must be selected. 

 
 

7.2.2 Status display of the devices 

After starting the project (see Section 7.5) and switching the representation 
in view mode, the status of each device and each infrastructure component 
in the locations tree is displayed. For this purpose, a dot is shown behind the 
device or infrastructure component. 
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Yellow dot  Status "warning" 
Red dot Status "alarm" 
Grey dot Status "timeout". The device could not be accessed 

for three successive query attempts.  
The status "timeout" hides (for the upwards 
inheritance in the structure tree) warning messages 
but not alarm messages. 

No dot Status "OK" 
 
 

7.3 Including third-party SNMP devices (MIB Browser) 
To also query data for third-party SNMP devices (non-Rittal devices with 
SNMP support), as of RiZone version 2.0, the "MIB Browser" function 
generates your own driver templates. The function must be enabled with an 
appropriate license key.  
RiZone Appliance licenses ordered on the basis of Rittal’s Catalogue 34 
contain the function automatically! 
 
The MIB (Management Information Base) of the third-party device must also 
be available. You can normally download the MIB from the device 
manufacturer's website.  

7.3.1 Creating drivers for third-party devices 

In admin mode (configure project), new drivers for SNMP devices can be 
created from the SNMP templates  tab. 
 

 
Fig. 18 SNMP templates tabs 

 
To create a new driver template, first click the Load SNMP templates  
button, right-click the root node in the SNMP templates  tab and select Add . 
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Fig. 19 Creating a new SNMP template 

 
In the dialogue that now opens, select the file path for the MIB of the device 
manufacturer and assign a name for the template. 
 

 

Note! 
MIBs that themselves contain 
references to another MIB cannot be 
used. Multi-part MIBs must be copied 
together prior to the import. 

 
A two-part window now opens in the main area of the GUI. The device MIB 
is displayed in a tree structure on the left-hand side. 
Now open the tree structure and find those variables (OIDs) whose values 
you want to query later from RiZone and use drag & drop to move them into 
the right-hand field. 
 
If tables in the MIB are used for a third-party device for which the index of 
the table is not maintained, the exact OID in the table field must be added 
from the RiZone MIB Browser.  
You can obtain the complete OID, for example, by means of an external MIB 
tool (such as “iReasoning MIB Browser”). The table in the MIB branch must 
be selected with the MIB tool. A “get bulk” can then be used to fetch all table 
entries. When the appropriate variable of the table is now selected, the 
complete OID will be displayed.  
The OID is augmented in RiZone in the “Table Rows” window of the RiZone 
MIB browser. An additional “HowTo” in PDF form is available on our website 
www.rimatrix5.com (Downloads > Software). 
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Fig. 20 MIB Browser with opened MIB 

 
If you want to delete a variable from the right-hand window, you can do this 
with a right-click > Delete . 
 

 

Note! 
You can obtain the description of the 
MIB and the meaning of the variables 
from the device manufacturer. 
Because of the large number of 
available SNMP devices, Rittal cannot 
provide any information about specific 
MIBs. 

 

 

Note! 
As of RiZone 3.0, it is possible to 
integrate traps for third-party devices 
in the driver. To do this, the status 
variable that initiates the trap like a 
normal variable is moved to the right-
hand side in the variable selection and 
the driver saved subsequently. 

Traps in the project are displayed both 
in the variables list and in the message 
window. 

 
Once you have moved all required variables into the right-hand window, you 
must now specify the details of the variables in the right-hand window. For 
details, consult Section 7.3.3.   
The driver must now be saved and loaded to the server. This is done by 
clicking Save driver . 
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Fig. 21 Driver details 

 
Further data is required before the driver template can be saved. 
 

• Template name  
The name of the template with which it will be stored later on the 
server must be specified in this field. The template name must 
conform to the general code conventions. This means, the name 
may contain only alphabetic characters (A-Z, a-z) and digits (0-9), 
and must start with an alphabetic character. Underscores are also 
permitted. If the input does not satisfy the specifications, the field will 
be displayed with a red frame and the OK button will be greyed-out.  

• MIB-II sysObjectID  
During the discovery action, the Enterprise OID of the driver will be 
compared with the “sysObjectID” variable of the device. Only when 
the Enterprise OID specified here matches that in the device can a 
device be found during the discovery action. 
Although RiZone normally automatically fetches the MIB-II 
sysObjectID from the MIB, it must always be checked. If the ID is not 
fetched correctly, you can normally find the sysObjectID in the 
“private“ branch or in the “mgmt >mib-2 > system” area of the MIB. 

• Condition description (begins with)  
In addition to the Enterprise OID mentioned above, a comparison is 
also made with the value in the “sysDescr” SNMP variable. 
However, the variable value does not need to be specified here, but 
only the start of the character string. A case-sensitive character 
comparison is made. The description only needs to be specified 
when several templates should be created for an MIB. 

• Devices (separated by a comma)  
Character strings to which devices the driver is assigned can be 
specified in the devices field. This input is used only to display the 
device information in the Properties window. Each individual device 
detail is separated with a comma. 

• Are bulk queries supported? (SNMP bulk query)  
This checkbox should be activated only when the associated device 
can supply all configured variable values by bulk query. 

 
Once at least the Name and Enterprise OID fields have been completed, the 
driver will be created automatically and loaded to the server when OK is 
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clicked. The driver template also appears in the template tree structure in the 
SNMP templates  tab. 
 
 

 

Note! 
In the “Driver details” dialogue, not 
only must the Enterprise OID be 
entered in the “Enterprise OID” field, 
but also the complete sysObjectID of 
this manufacturer's device. 

 
 

7.3.2 Including third-party SNMP devices in the project 

Once the driver has been created, third-party devices can be found with the 
discovery function and transferred to the project (locations or devices tree). 
See Chapter 7.2. 

7.3.3 Third-party SNMP devices – variable details 

Variables found with SNMP templates and included in the project differ from 
the details of a Rittal device.  
 
You find the variable details of a third-party device variable when you have 
already moved variables into the right-hand window of the MIB browser. 
Double-click the variable to be edited.  
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Fig. 22 Variable properties of third-party devices 

 
Variables 
property 

Description 

OID Object ID of the variable to be polled. It is determined by 
moving the appropriate variable from the MIB tree. 

Name The name of the variable displayed later in the variable 
list. It must have a unique designation in the driver. 

Data type RiZone-internal data type. It is used for the visualisation 
and status evaluation of the variable. 
StatusInt -> Numeric value that RiZone should translate 
as status 
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Float -> Measured values and setpoints as floating-point 
number 
String  -> Character string 

SNMP data 
type 

SNMP standard data types (INT, OCTET_STRING, 
OBJECT_IDENTYFIER). If possible, the SNMP data type 
is initialised from the MIB. 

Write access The write access can be selected when a variable can 
generally be written using SNMP. The RiZone 
administrator has the capability here to further limit the 
write rights of a variable. 

Display type The RiZone-internal type used to display the values. The 
type defines the appearance and behaviour of the 
Setting window of the variable. 
TYPE_ASCII_XSS_STRING -> A string checked for 
Cross-Site Scripting (security mechanism to prevent 
infected source code from being imported). When this 
display type is selected, Minimum and Maximum define 
the minimum and maximum character length, 
respectively. If it should be possible to set the value, 
these must be specified appropriately.  
TYPE_FLOAT  -> Set a floating-point value 
TYPE_PASSWORD -> Passwords are displayed as 
asterisks. 
Combo-values are stored separated with a comma. The 
first value is the selected default value; the various 
selection possibilities follow. 

Interval The specification in which time intervals RiZone should 
cyclically poll the variable. The time is specified in 
seconds. 

Meaning The meaning defines the access to the variable. 
The meaning causes the associated right to be assigned 
automatically to the variable. State and Value are 
assigned the “Read” right. Service is assigned the 
“Configuration” right. The Set buttons are also created 
using this setting: Only those variables with the Setting, 
Configuration, Execute or Service setting are displayed 
and then only when write access is activated for this 
variable. 
 
State  -> The variable will be translated as state variable. 
Integer values are translated to the OK, Warning or 
Alarm state. If State is selected as meaning in the 
combobox, three additional input fields appear for the 
default values of the state translation. One or more 
unsigned integer values can be entered for each field. 
The inputs must be separated with a semicolon or a 
minus (input of a range).  
Note: “String” must be selected as display type. 
 
Value  -> Values that can only be displayed (example: 
text items or temperature values). 
Setting  -> Setting variables can be written from the GUI 
to the SNMP device. If Setting is selected in the 
combobox, limits must also be entered in the Minimum 
and Maximum fields. These define the settable range 
and the standard axis section for the chart. A step size 
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intervals the variables can be set (example: 0.5). This 
type is assigned in the rights assignment to the Setting 
right. 
Configuration  -> This type is assigned in the rights 
assignment to the Configuration right. 
Service  -> This type is assigned in the rights assignment 
to the Service right. 
Execute -> This type is assigned in the rights 
assignment to the Execute right. 
 
Setting, Configuration, Service and Execute are 
configurable variables in RiZone and are displayed with 
the Set button provided the Write right has been 
assigned. All other types are assigned the Read right. 

Step size This field specifies the minimum distance between the 
values that can be set. It is used only when SNMP 
values are also marked as settable . The distances can 
be specified as Float number; that means, also contain 
decimal places. This field does not have any effect on 
the display of the values but only on the Setting dialogue. 
It is displayed only when the write access is selected and 
Setting, Configuration, Service or Execute specified as 
meaning. 

Unit The string that can be entered here is used to display in 
which unit of measurement a value should be displayed 
on the GUI. Example: °C, V, kW, ... . 

Display factor The display factor specifies a multiplier with which the 
data value stored in the database is converted before it is 
displayed on the GUI. The factor can be specified as 
Float number. The display factor is called Factor in the 
variable list of the GUI. Example: convert power value 
from W to kW with the factor 0.001. 

Display 
format 

Defines the numeric format with which the value is 
displayed: 
“0”: Replaces the digit 0 with the specified digit (if 
present), otherwise the digit 0 is displayed on the result 
character string. 
“#”: Replaces the “#” symbol with the specified digit (if 
present), otherwise no digit is displayed on the result 
character string. 
“.”: Specifies the position of the decimal separator in the 
result character string. 
“,”: Thousands separator 
Example 1: 
Display format: 0.0# 
Value = 1,234 
Output: 1.23 
Example 2: 
Display format: #,##0.00 
Value = 1234,1 
Output: 1,234.10  

Factor The factor defines the multiplier with which the fetched 
SNMP value is written in the database. It can also be 
specified as Float number.  
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Example: voltage value with one decimal place (230.2V -
> SNMP value 2302) -> specification factor: 0.1. 

Minimum The minimum value for which settable values can be set 
later by the user in a device via SNMP. For strings, the 
value defines the minimum number of characters that 
must be entered; for numbers, the minimum numeric 
value that can be entered. For measured values, this 
value defines the default entry for the smallest value 
shown in the chart (Min-Y). 

Maximum The maximum value that can be set. For strings, the 
value defines the maximum number of characters that 
may be entered; for numbers, the maximum numeric 
value that can be entered. For measured values, this 
value defines the default entry for the largest value 
shown in the chart (Max-Y). 

Group Classification of variables into a category of infrastructure 
functions.  
The following can be selected: 
- Cooling 
- Power 
- Monitoring 
- Security 
The assignment to a functional area is of particular 
importance for the evaluation of status variables. 
Graphics change their colour depending on the status 
only when the variable is assigned to at least one 
functional area. The status value is also included in an 
overall status of the functional area. The selection is 
used and displayed only for status variables. 

 

7.3.4 Deleting a template 

A template can be deleted in the SNMP templates tab. To do this, right-click 
the template to be deleted and then select Delete  in the context menu. The 
subsequent delete prompt must be confirmed with OK. 
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Note! 
After the deletion, no new devices can 
be discovered using the template.  
After restarting the GUI, existing 
devices in the project will also no 
longer be displayed! 

 

7.3.5 Changing an existing template 

To change an existing template, right-click the template in the SNMP 
templates tab and select Edit . The MIB associated with the driver and the 
variables selected for the driver now opens in the main window. These 
variables can now be augmented, changed or deleted. The driver must then 
be saved again with Save driver .  
The changes affect only those devices discovered after the change. 
If the template name is changed when the save is made, a second template 
will be created with the new name. The old template is also retained. 
 

 

Note! 
Drivers must be unique. If a second 
driver should be generated from the 
same MIB, the device assignment 
must be made uniquely using the 
“Condition description (begins with)”. 

 

7.3.6 Creating a template symbol for views 

You can create for the created template a standard symbol that can be 
added later to the views in the project and then behaves similarly as the 
supplied symbols for the Rittal components. 
To create a standard symbol, right-click the required template on the SNMP 
templates tab and select Symbol . 
The View editor now opens in which you can construct the standard symbol 
from the following components: 

• Polygons 
• Variables 
• Free text 

 
The creation is performed similarly as the creation of a normal view (see 
Section 8.6). 
 
Once the symbol has been created, the editor must be closed with Views > 
Save view . A red exclamation mark now appears after the template in the 
SNMP templates tab, because the template itself has not yet been saved in 
the current configuration. 
Save the template with right-click > Save . 
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7.3.7 Creating standard charts 

The Standard Charts function creates charts for the template that are 
created automatically with each device moved into a project. 
To create a standard chart, right-click the required template on the SNMP 
templates tab and select Standard Chart . 
The Chart editor now opens in which you can create charts similar to the 
creation of a normal chart (see Chapter 9). Only the variable source no 
longer needs to be selected with drag & drop. You have direct access to all 
numeric and Boolean variables that have been defined in the template. 
  
The standard chart must be saved with Charts > Save charts . 
A red exclamation mark now appears after the template in the SNMP 
templates tab, because the template itself has not yet been saved in the 
current configuration. 
Save the template with right-click > Save . 
 

 

Note! 
If a standard chart is added subsequently to a driv er, 
the appropriate devices must be rediscovered and 
with pressed Alt key dragged to the “old” devices. 
To activate the chart, a new chart must be created 
and edited. The standard chart settings can then be  
accepted with “Charts > Load standard charts”. This  
procedure prevents an existing, individual chart fr om 
being automatically overwritten by the default char t.  
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7.4 Editing components 

All functions listed here are available in admin mode for RiZone. 

7.4.1 Deleting components 

Right-click the component to be deleted and select the Delete  item in the 
context menu. 
The component will be deleted immediately from the tree structure. 
If a device is deleted in the Locations tree , it is still present in the project 
and in the Devices  tree. If, however, a device is deleted in the Devices  tree, 
it will also be deleted in the Locations  tree. Calculations that contain a 
variable of the deleted component will be deactivated. Both messages will 
be displayed in the GUI message window. 
 

7.4.2 Copying infrastructure components 

Right-click the component to be copied and select the Copy  item in the 
context menu. Then select in the locations tree the infrastructure 
components with a left mouse-click under which the copied component 
should be added. Then right-click the component > insert . The previously 
copied component now appears as copy under the previously selected 
position in the tree. Note that only infrastructure components but no sensors 
/ active components can be copied with this function. 
 

7.4.3 Moving components in the tree   

The moving of a component in the location or devices tree within a node is 
made in admin mode with a right-click on the component and the selection of 
the Arrow up  or Arrow down  menu tree. 
 
If several components should be moved to another node, the components 
can be selected with multi-select (pressed Ctrl or Shift key) and then moved 
together with drag & drop. To retain the structure of the subcomponents 
during the move, the infrastructure components (e.g. several racks) must be 
selected individually with Ctrl. A multiple selection over an infrastructure 
component area (with pressed Shift key) may change the hierarchy after the 
move. 
 

7.4.4 Transferring a component from the devices tree to the 

locations tree 

Components used only in the devices tree but not in the locations tree can 
be transferred to the locations tree with the Add to locations  function. 
To do this, right-click the component in the devices tree and then select Add 
to locations . The component will then be added at the end of the project in 
the locations tree from where it can be moved to any position in the project 
with drag & drop. 
 

7.4.5 Counting IP nodes 

The Number of IPs in the project  function determines the number of IP 
nodes used in the project. This is useful, for example, when you want to add 
new devices to the project and want to check beforehand whether the 
license key provides sufficient free IP nodes. 
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To determine the used IP nodes, switch to the devices tree, right-click the 
root node and select the Number of IPs in the project  function. The 
number of used IP nodes will now be displayed. 
 

7.5 Starting a project 

Before a project can be started, it must first be uploaded to the server. This 

is done from the Project > Upload to server main menu or with the  
icon. The prompt whether the project should be uploaded must be 
confirmed. The upload to the server has completed once the “Validation 
completed, the project has been uploaded to the project folder” message 
appears in the message list. 
The created RiZone project will now be performed on the server and so all 
active components also fetched using SNMP and any created workflows 
performed. 

Project > Start project  or  is used to switch the RiZone client to view 
mode. The live data arriving at the server can be displayed in view mode. In 
this mode, the user also has access to the historical values that have been 
collected since the start of the project. These values, for example, can be 
displayed using charts. 
All project start messages are listed in the message list. The prompt whether 
the project should be started must be confirmed. 
 

7.6 Editing a project 

If necessary, an existing project can be changed. To edit the project, the 
user must be in GUI admin mode. The project can be downloaded from the 
RiZone server or opened locally from the hard disk. The project is 
downloaded from the Project > Download from server  main menu or with 

the  icon. The project can now be edited. 
The original project will continue to run until the modified project has been 
uploaded to the server. The editing of the project does not affect any other 
users. 
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7.7 Displaying values and variables 

Once the project has been started, RiZone can be used to easily display all 
available values that the individual components supply. 
Example CMC III temperature sensor: 

• Right-click the required sensor (locations tree or devices tree) in the 
left-hand window. 

• Select Variables  in the context menu. 
• The sensor variables will now be listed in the View window (right-

hand side). All acquired values (in Fig. 18, the temperature) and the 
settings (Temperature.DescName, SetPtHighAlarm, 
SetPtHighWarning, SetPtLowWarning, SetPtLowAlarm, Hysteresis) 
will be output. 

 

 
Fig. 23 Output values in the started project 
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If the variables of a higher-level component (e.g. room or enclosure) are 
fetched, a list with all sensors, PSM busbars, etc. assigned to the component 
opens in the View window. A click on the arrow in front of a sensor then 
shows its values. 
 

 

Fig. 24 Variables of an enclosure (rack 1) 

 
The Monitoring, Cooling, Security, Availability and Power status variables 
describe the status of the associated groups of this infrastructure 
component.  
CapacityStatus and RackStatus are status variables of the capacity 
management. The associated details are described in Section 15. 
TotalStatus provides the overall status of the infrastructure component over 
all groups. 
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branches in the maintenance mode. Devices in maintenance mode are not 
used to determine the status. 

7.8 Displaying values from the website 

An alternative means of displaying sensor values involves calling the website 
of the components. 
In admin mode, the properties of the device (right-click > Properties)  
selects whether an HTTP, an HTTPS  or no web connection should be 
established. The web connection itself is called from the context menu of the 
device in the locations or devices tree. 
 
A right-click on the component and the selection of Open website  opens a 
browser window in which the website of the component (e.g. CMC III 
Processing Unit) is called.  
 

 

Note! 
The following functions are available 
only when you are in admin mode. 

Log in with a user who is member of 
the RiZone administrators group. 

 

Note! 
Changes take effect only after the 
project is uploaded. 

Save the project and upload it to the 
server. 

 

7.9 Creating a new variable 

Variables can be created in RiZone. These variables are assigned to an 
infrastructure component (e.g. room, enclosure, etc.). The variables can be 
used within charts, views, etc. A value can be assigned to the variables via 
the set function, a workflow or a variable calculation.  
A new variable is created by right-clicking in the variable view and selecting 
the New variable in [location]  item in the menu. 
 
Input possibilities for creating a new variable 
Name Name of the variable. 
Description Description of the variable. 
Type Float  and StatusInt  are possible as variable type. 

Float is used when a (float) numeric value is stored in 
the variable, StatusInt for status variables. 
Important note:  The variable type can be selected 
only when the variable is created. A subsequent 
change is not possible. 

Publish If set, the variable will be passed to the Messaging 
Service. The variable can now be fetched via SNMP 
by a different system. 

Interval Specifies the calculation cycle (in seconds). Off  
means that the variable will be calculated once after 
the project is uploaded. 
Important:  If this a variable calculated by a 
calculation function based on other variables, interval 
1800 must be selected instead of off . This ensures 
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that the variables required for the calculation have 
already been polled. 

Write access If the field is set, the variable may be set manually or 
assigned a value. The associated dependencies are 
described in Section 7.17   

Meaning Meaning of the variable (Undefined, State, Value, 
Setting, Configuration, Service, Execute). 

Phys. 
measurement 
quantity 

Specifies the measurement quantity of the variable. 

Unit Specifies the unit of the variable. 
Display factor The variable is multiplied with the entered value and 

the result shown. 
Display format Defines the numeric format with which the value is 

displayed: 
“0”: Replaces the digit 0 with the specified digit (if 
present), otherwise the digit 0 is displayed on the 
result character string. 
“#”: Replaces the “#” symbol with the specified digit (if 
present), otherwise no digit is displayed on the result 
character string. 
“.”: Specifies the position of the decimal separator in 
the result character string. 
“,”: Thousands separator 
Example 1: 
Display format: 0.0# 
Value = 1,234 
Output: 1.23 
Example 2: 
Display format: #,##0.00 
Value = 1234,1 
Output: 1,234.10 

Group Selection of the group of the variable. 
The selection of the group affects the group status 
variables of the component to which the variable in 
the project is assigned. If the variable is assigned to a 
group and changes its status, the group status 
variable of the higher-level infrastructure component 
also changes its status on the variable (exception: the 
status of the group status variable has already been 
raised to a more critical status by a different variable). 

 

7.10 Editing a variable 

Variables can be edited in RiZone. A variable is edited by being right-clicked 
and the Edit variable  item selected in the menu. 
If the Availability  group is selected, note that the group responds only to a 
specific status. For example, it does not respond to status such as too high , 
too low , warning . 
The Remoting  group does not have any effect on the status of higher-level 
views. If an alarm status occurs in the Remoting group, this is not signalled 
in the view by the colour of the rack. 
The variable name and the physical measurement quantity cannot be 
changed. 
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Once a variable has been created, it can be moved within the locations tree. 
Please proceed as follows: 
• Open the variables overview of the structure components (e.g. of a rack) 

that contains the variable to be moved. 
• Left-click the user-created variable are move with drag & drop to another 

structure component. 
The variable is now moved to the new location in the locations tree. 
 
The copying of a user-created variable to another structure component is 
also possible.  
Please proceed as follows: 
• Open the variables overview of the structure components (e.g. of a rack) 

that contains the variable to be copied. 
• Left-click the user-created variable are copy with drag & drop and 

pressed Ctrl key to another structure component. Note that the cursor 
icon is augmented with a small + symbol. 

The copy action creates an identically-named variable with a new variable ID 
under the target structure component. The variable properties are also 
copied, but not any calculations configured in the source variable. The 
calculation for the source variable itself remains unaffected by the copy 
action. 
 

7.12 Deleting a variable 

Variables you created in RiZone can be deleted. A variable is deleted by 
being right-clicked and the Delete variable  item selected in the menu. 
 

 

Note! 
Only those variables you created 
yourself can be deleted. 

 

7.13 Grouping of variables 

The grouping of variables makes it possible with a SET command to set 
several values in RiZone. The grouped variables can be set from a workflow, 
from a view and from the grouping tree. 
Folders and groups can be added to the grouping tree. A folder can contain 
multiple subfolders and groups. A grouping can contain further groupings but 
no folders. A grouping can contain only variables of the same type, such as 
temperature values. The groupings inherit the value when set lower in the 
grouping hierarchy. 
The following properties of the variables must be identical when they should 
be combined in a group: unit, value range and variable type. 

7.13.1 Creating a grouping 

A grouping is created in admin mode. A grouping is created and edited 
similarly as for a location component. As many as 64 groupings can be 
created under each other. 

7.13.2 Creating a folder 

A folder is created in admin mode. A folder is created and edited similarly as 
for a location component. As many as 128 folders can be created under 
each other. 
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7.13.3 Assigning a variable to a grouping 

A variable is assigned to a grouping in admin mode with drag & drop from 
the variables list of the devices or locations tree. Only identical, write 
variables can be assigned to a grouping. 

7.13.4 Setting a grouping variable 

A variable is set from the GUI in view mode in the grouping tree, from a 
workflow or from a view. 

7.13.5 Grouping tree 

The grouping is selected with a click. A right-click opens the menu. Select 
the Variables  menu item to open the variables window opens in the main 
window. The grouping variable to be set is selected. The multiple selection is 
made similar to the variables table of a component. 
Select Set value  to open a window in which the variable is set immediately. 

7.13.6 Workflow 

The grouping can be included in a workflow like a normal variable. 

7.13.7 View 

A group is configured in the admin mode similar to adding a variable to the 
view. Rather than associated component, the grouping is added to the 
selection box for the variable. If the grouping in a view is configured, the 
grouping in view mode behaves similarly to a variable. The values within the 
grouping are displayed with a right-click and the variables selection 
displayed in a separate window. To set variables of a grouping within a view, 
right-click and select Set value . The variables window of the grouping opens 
for setting the variables within the grouping. 

7.13.8 Grouping with devices configured offline 

The variables do not have any units for grouping with devices configured 
offline. Consequently, RiZone cannot check whether variables of the same 
type are added to a grouping. Ensure that the variables in a grouping always 
have the same type.   

7.13.9 Grouping with user-created variables 

The grouping of user-created variables is possible only if they have the 
Setting function type  and they can be written. All variables must have the 
same unit and the same value range. 
 

7.14 Calculating a numeric variable 

RiZone can calculate variables. Self-created variables (Float  type) can be 
used to link variable values mathematically, for example, those supplied by 
sensors. The self-created variables can then be used further within RiZone, 
for example, for display in charts or in workflows. 
  
Predefined functions exist and you can create your own formulas. The 
functions offer the following calculations: Custom, Sum, Minimum, Maximum, 
Average, Delta, Number of changes, Integral, Percentage and Consumption.  
The Custom function allows the use of the four basic arithmetic operations, 
brackets and Boolean algebra in order to create your own calculations.  
 

Function name Function 
Sum Summation function  
Minimum Minimum value of a variable within an interval 
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Average Average value of a variable within an interval 
Delta Maximum change of a variable within an interval 
Number of changes The number of changes of the variable value within 

an interval 
Integral Integral of a variable within an interval 
Percentage Convert a variable value into a percentage  
Consumption Calculate the consumption from a power variable 

within an interval 
 
The interval for functions can be minute, hour, day, week, month, year and 
now. The interval always starts at the beginning of a minute, hour, etc., other 
than for theNow  interval. In this case, the start date is specified in the format 
dd.mm.yyyy hh:mm:ss. 
 

 

Fig. 25 Interval selection from the dropdown menu 

 

7.14.1 Selecting a variable 

Only self-created variables of the Float  type can be calculated. To select the 
variable, the variable view of a component must be opened in admin mode. 
A right-click opens the context menu of the variable and selects the 
Calculate variable  entry. 
The Calculate <variable name>  menu opens. 

7.14.2 Selection of the component for calculating the variable 

The component is selected using drag & drop. The component that contains 
the variable required for the calculation is selected in the project tree. Drag 
the component to the Select variable  field in the variable calculation 
window; you then have access to all available values of the component. 
 

 

Note! 
Only those components that contain 
numeric variables can be selected. 
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Important! 
RiZone calculates logical operations 
bitwise. This means the status is 
linked based on its bit structure: 

OK: 001 
Warning: 010 
Alarm: 100 

 

7.14.3 Selection of variables 

Once the component has been selected, all variables will be displayed in the 
window. These variables are selected individually and with the Down arrow  
button transferred to the variable list. Only numeric variables can be 
selected. 

7.14.4 Transfer of the variables to the formula field 

A variable is transferred to the formula field by being marked with the left 
mouse button and transferred to the formula field by copying the variable 
with Ctrl-C  and pasting the variable with Ctrl-V . 

7.14.5 Creating the formula 

The mathematical expression is created in the formula window for the 
Custom function. The four basic arithmetic operations, Boolean algebra and 
the setting of brackets are available. 

7.14.6 Checking the calculation 

RiZone checks the formula for mathematical correctness. If the formula is 
correct, it can be saved. The check is initiated by clicking the Validate  
button. 

7.14.7 Saving the formula 

If the formula has been validated successfully, it can be saved. To start the 
calculation, the project must be loaded to the server. 
The formula is saved by clicking the Save button. 

7.15 Calculating a status variable with float values 

In addition to the normal variables that contain numeric values, status 
variables can also be created. Although status variables can be created on 
any infrastructure component (see Section 7.9), StatusInt  and State  or 
Execute  must be selected as type and meaning, respectively. 
The status variables can assume the values: ok , warning , alarm or 
undefined  are calculated in the following form: 
if <number || variable> <operators> <number || variable> then 
<ok||alarm||warning||undefined> else <alarm||warning||undefined>  
   
Example: if VAR_4711 > 30 then ok else alarm 
A space must be present before and after the operator. 
The use of the and , or , not  logical operators is also possible. These 
operators must always be used with Boolean operators, such as: 
if not( a > b and c != b ) then ok else warning 
 or  
if (a < b) and (c == d) then ok else alarm 
 or  
if ( ((a + b) < c) or ((x - y) == z) ) then warning  else alarm  
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The calculation could have the following form in practical use: 
if VAR_4711 > 30 and VAR_0815 < 40 then ok else ala rm 
  

 

Important! 
The calculation of a status variable 
with float values must always contain 
the command structure if .. then .. else 
..  
  

 
 

7.16 Calculating a status variable with status values 

A status variable can be calculated from several status variables. The 
variable to be calculated must have the type StatusInt  and State  or Execute 
meaning set. Several status variables can be linked logically with each other. 
The result of the new status variables corresponds to the operation. 
 

 

Important! 
In the calculation of a status variable 
with status values, the result of an &-
operation is undefined provided not all 
status values are equal! 

 

7.17 Setting user-defined variables 
A user-defined variable can be set from the variables list in the GUI or in a 
created view by the user provided the appropriate authorisation is given. The 
write access from an external system is possible provided the prerequisites 
described in Section 16.4 are satisfied. A variable created in RiZone can be 
changed provided the write-access  field was activated when created and 
the variable is adapted appropriately depending on the FunctionType data 
type.  
The Setting FunctionType must be selected for a Float variable. RiZone then 
interprets this variable as setpoint. The value range for this variable must be 
adapted. 
For a status variable, StatusInt and Execute must be configured as data type 
and as FunctionType, respectively.  
All status information in the Set Value  menu is then available. 
 
 

7.18 Offline configuring 

The offline configuring can be used to configure a RiZone project in 
advance. The offline configuring does not require an IP connection to the 
CMC III components to be configured. 
The project is created identically as for a normal project. Select the Offline  
tab in the discovery window (Edit > Discovery  menu).  
The Offline tab shows all CMC III devices and the LCP available for the 
offline configuring. 
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Important! 
For the offline configuring, ensure that 
the CMC III PU to be configured later is 
installed with version level 3.13.xx or 
later. 

 

 
Fig. 26 Sensors that can be configured offline 

 
These devices can be dragged to the locations tree (not in the devices tree) 
and marked with an additional icon. Most adaptations also possible in a 
RiZone project with real devices can be made. For example, the configuring 
of views, charts, workflows and reports, and the creation of calculations. 
If the configuration area is completed and the active real devices and 
sensors are recognised by a normal discovery; the devices and sensors can 
then be dragged individually with drag & drop to the dummy devices of the 
offline configuring in the locations tree. Each node must be assigned 
individually. The offline device is replaced with the real device. The symbol 
that indicates an offline device is deleted. 
When the project is saved, all links configured during the offline configuring 
are transferred to the active devices and sensors. 
Note that the following restrictions exist for the offline configuring: 

• Not all variables of the devices are visible offline. 
• The PUIII root node cannot be dragged offline to the locations tree. 
• Each sensor appears with its own PU in the devices tree. This is 

corrected and the number of PUs reduced once the offline sensors 
have been replaced with the real sensors. 

• Adapt the designations of the devices in the locations tree already in 
offline mode. The offline designation is retained for the transfer of the 
real sensors. 
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variables such as SetOn or SetOff) can be configured only with real 
devices. 

• Chart configuration: Settings (e.g. Min/Max values of the axes) must be 
entered manually for the offline creation. They are not replaced later 
with the default values of the individual devices. 

 
The project can now be uploaded to the server and works just like a 
traditionally configured project. 
 

7.18.1 Offline configuring of a RiMatrix S module 

The offline configuring of a module for a standardised RiMatrix S data centre 
deviates from the procedure described in the previous section. 
The discovery function is not used to create a RiMatrix S module. Instead, 
the modules can be created in the locations tree with a right-click on an 
infrastructure component of type Location > Add . The RiMatrix S module 
(e.g. Single6) can now be selected in the Component type  selection box. 
Click OK to create offline below the infrastructure component all components 
and devices required for the RiMatrix S module. Views, charts and variables 
(PUE, PUE_absolute, PUE_day, PUE_hour, PUE_year) are also generated 
automatically for some components.  
  
The components are given an English name irrespective of the language 
setting made for the RiZone client.  
RiMatrix S modules currently available: Single 6, Double 6, Single 9, Double 
9. 
The replacement of the offline devices with real devices is done similarly as 
for the procedure described in Section 7.18. 
 
 

7.19 Export/import project 

The Project > Export project  and Project > Import project  functions 
transfer projects to other servers. 
 
Export project 
An uploaded project can be exported. This also stores the 
ClientRegistration.txt and NameRegistration.txt files in the project file. 
 
 
Import project  
This function imports an exported project to the same or another RiZone 
server (with the same version number). This deletes all entries in the 
database (ClientRegistration and NameRegistration) and replaces them with 
the registrations from the imported project.  
Using the import/export function, projects can be ported between different 
computers.  
For this purpose, the two NameRegistration.txt and ClientRegistration.txt 
files are also uploaded when a project is uploaded and the entries written to 
the database when the RiZoneCore service is restarted. A check is also 
made to ensure that the project, the settings of the Communication Module 
and the DB match. These registrations make the project also operational on 
servers on which the devices were not detected previously with the 
discovery function. 
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This differs from the save/open project by the registration database entries 
also being saved. 
 

 

Note! 
After the import of a project, it is 
possible that other projects of the 
server that were saved with the “Save 
project” function will no longer operate 
correctly. If you want to reuse these 
projects later, you must save them 
previously with the “Export project” 
function. 

 

 

Note! 
Self-created SNMP templates are not 
transferred when a project is exported. 
If a project that contains SNMP 
templates for third-party devices is 
“moved” to a different server, third-
party SNMP devices on the new server 
will not be recognised.  
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8 Views 
The views can be used to create graphical representations of your complete 
infrastructure components.  
Views can be created for each component in the locations tree. A 
differentiation between the lateral view and the plan view is made for the 
representation of the views. Whereas the location, building and room 
component types have a plan view, the enclosure suite and the enclosure 
have a lateral view. 
Customised graphics (e.g. the floor plan of a computing room) can be 
created for plan views. The graphic can be manually overlaid with active 
buttons that indicate the status of the components. For the lateral views, the 
corresponding graphics of the enclosures and components are already 
present in RiZone and only need to be assigned appropriately to the project. 
The views are configured in admin mode. 
 

 

Note! 
Status variables must be assigned to a 
group so they can be evaluated 
coloured in the view. 

 

8.1 Creating a new view 

The selection of the Views  menu item creates the view for a component. 
Only the view for one component can be edited concurrently. 
The view opens in edit mode in the main view of the GUI.  
A view is created by right-clicking the component icon. A context menu now 
opens and the View  function can be selected. Alternatively, moving the 
mouse over the component displays five icons. The second icon from the left 

 opens a new view. 
The new view must first be scaled before it is created. This function creates 
scaled views on the component level because all RiZone components exist 
as SI units. 
Scaling is made in mm and can be given a scale. 
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8.2 Editing a view 

A previously opened and stored view is opened for editing by calling the Edit 
view  function in the View  menu. 
The opened view has a pink frame that indicates the editing mode. 

8.3 Loading a background picture 

A right-click in the view window opens the dialogue for loading a background 
picture. Call Load background  to open the Open file  window from which a 
.jpg format file can be selected. The file size of the picture may not exceed 1 
MB. 
The background picture will be created. 

8.4 Assigning a component to a drawing 

A component is assigned to the view by dragging to the drawing. The mouse 
can be used to place the component anywhere in the view. 

8.5 Saving the view 

A view is saved by calling the Save view  function in the Views  menu. 

8.6 Operating the views editor 

The views editor provides the following functions: 
 Zoom 

 Rotate 

 Draw polygon 

 Add text 

 Display variable in the view 
 Undo 

 Step forwards 

8.6.1 Zoom 

The zoom function can be performed by clicking the Magnifying glass  icon 
or by pressing the Ctrl key  and using the mouse wheel . 
 
Selecting the magnifying glass  activates the zoom function. It is now 
possible to zoom a rectangle from the view. A subsequent right-click restores 
the original size. 
 
A view can be zoomed by pressing the Ctrl key  and the mouse wheel . The 
view must be clicked to perform this function. The zoom function is then 
available. Pressing the right mouse button restores the original size. When 
the mouse wheel is turned forwards, zooming is made into the view; when 
the mouse wheel is turned backwards, zooming is made from the view. 
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8.6.2 Rotate 

A component in a view is rotated at the movable rotation point of the 

selected component. The Rotate  icon is a sector of a circle with arrow . 
The component is selected in the view and then the Rotate  icon selected. 
Once the rotate function has been selected, the component can be rotated. 

8.6.3 Polygons 

The RiZone editor can be used to draw a polygon and then assign this 
polygon to a RiZone infrastructure component. The polygon in the drawing 
uses the colours green, yellow and red to indicate the three states of the 
component: OK, warning and alarm. 
 

 

Note! 
Status variables must be assigned to a 
group so they can be evaluated 
coloured in the view. 

 
The Polygon  icon is used to activate the drawing of a polygon. A left-click 
can now be used to add a corner of the polygon. A double-click closes the 
polygon. 
 
A drawn polygon can be edited in drawing mode. Individual corners can be 
moved or corners added (arrow cursor and Ctrl  right-click on a line ) or 
deleted (arrow cursor and Ctrl right-click ). 
 
A polygon can be assigned to a component in the component tree. Please 
proceed as follows: 

1. Mark the component in the locations tree. 
2. Keep the Alt  key pressed. 
3. Now drag & drop the marked component to the required polygon. 

If the action completed successfully, the polygon colour changes to green. 
 
Polygons can be copied. Mark the polygon and right-click > Copy . Right-
click > Add  adds a copy of the polygon to the view. Only the actual polygon 
is copied not any assignment to a component.  

8.6.4 Placing components in the view in the foreground or 

background 

When a view is created, the last component is always placed in the 
foreground. If the sequence for a view should be changed, this is done with 
a right-click on the associated component. The To foreground  or To 
background  selection changes the sequence. 
 

8.6.5 Displaying free text in a view 

The Text  function can be used to display any free text items in a view. 
The view must be open in edit mode. Click the Text  icon in the editor toolbar. 
Then click the view position where the text should be displayed (the 
placement can be changed subsequently). A text input window opens. Enter 
the required text and click OK to confirm. 
Once the project has been loaded onto the server, the text will be displayed 
in the view. 
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8.6.6 Displaying and changing variables in a view 

The V function can be used to display any variable values in a view. 
The view must be open in edit mode. Click the V icon in the editor toolbar. 
Then click the view position where the values of the variable should be 
displayed (the placement can be changed subsequently). A variable 
selection window now opens. Move a sensor or a component with drag & 
drop into the variable field. You now have the selection of all values of the 
sensor or the component. Select the required variable and click OK to 
confirm. It can also be specified whether the name of the variable or free text 
should be displayed together with the variable. This selection, the variable 
value and the unit will be displayed in the view once the project has been 
loaded onto the server. 
If the variable can be set by the user, the variable value can also be set in 
the view (view mode).  
A double-click on the variable opens the Set variable  window. The Set 
variable  window has the same functional scope as in the variable view. 

8.6.7 Undo 

The Undo  function undoes the creation steps. 

8.6.8 Restore 

The Restore  function undoes the undo function. 

8.6.9 Multiple selection 

A multiple selection of components is possible by drawing a frame around 
the components to be selected. The selected components are coloured. 

8.6.10 “Go to” and “Open website” functions 

If a view is open, a right-click on the individual components (e.g. PSM 
busbar) calls a context menu. Depending on the component and the 
configuring, none or one of the Go to  or Open website  options appears 
here. 
 
Go to  
The view of the clicked infrastructure components opens. This is possible 
only when the view was created previously in admin mode. 
Example: In the multiple-enclosure view, a right-click is made on a specific 
enclosure and Go to  selected. The enclosure view (provided created) of the 
selected enclosure now opens. 
 
Open website 
A right-click on a sensor opens the context menu with theOpen website  
option. The selection of the Open website  item opens in the standard 
browser the website for the sensor. 

8.6.11 View list 

The view list of a component can be called from its context menu (right 
mouse key). 
In admin mode, existing views can be edited or new views created in the 
view list. 
In view mode, a selection from the existing views can be made. A double-
click on the view opens it. 
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9 Charts in RiZone 
The chart function displays measured values graphically in RiZone. It is 
possible here to display several values in a diagram. 
Charts must be grouped in admin mode. When the project is started, the 
created charts can be called and then show the current and historic acquired 
values. 
The chart list shows all charts assigned to the infrastructure component. The 
context menu (right-click), new charts can be created or existing charts 
renamed or deleted. 

9.1 Creating charts 

Charts are linked to a component (sensor, PU, LCP, etc.) or an infrastructure 
component (location, building, room, enclosure suite, enclosure) during their 
creation. For a started project, these charts can then be called using the 
appropriate (infrastructure) components. 
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Fig. 27 Creating a chart 

 
To create a new chart, right-click the component with which the chart is 
linked and select Charts  or Chart list . The chart list shows all charts 
assigned to the infrastructure component. From this list, the required chart 
can be selected with a double-click or a new chart created with right-click  > 
New. 
 
The chart configuration now opens in the View window.  
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Fig. 28 Chart configuration 

Legend 
1 Add/remove a new chart 
2 Add/remove a diagram within a chart 
3 Add/remove a variable to/from a diagram 
 
Input possibilities in the chart configuration 

Name Name of the chart 
Description Description of the chart 
  
Name Diagram name 
Diagram type Representation of the values in the diagram as 

line, pie or bar chart (Gantt) 
Colour Measuring curve colour. Clicking the colour opens 

a colour selection palette that can be used to 
specify the colour for this measured value.  

Description Description of the measured value 
Axis caption Title of the Y-axis for this measured value 
Variable The measured value to be displayed is selected 

here. 
Drag & drop a component from the project tree to 
the Variable  field. The drop-down menu can then 
be used to select all available measured values of 
the selected component. This value will then be 
displayed later in the diagram.  

Min-Y Minimum value of the Y-axis. It should be adapted 
to the expected minimum value of the selected 
measured value. 
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Max-Y Maximum value of the Y-axis. It should be adapted 
to the expected maximum value of the selected 
measured value. If Min and Max = 0 are specified, 
an automatic scaling will be performed. 

Unit Unit of the acquired measured value  
Axis Selection of the associated axis. If several units 

are used, each unit has its own axis. 
Format Defines the numeric format with which the value is 

displayed: 
“0”: Replaces the digit 0 with the specified digit (if 
present), otherwise the digit 0 is displayed on the 
result character string. 
“#”: Replaces the “#” symbol with the specified digit 
(if present), otherwise no digit is displayed on the 
result character string. 
“.”: Specifies the position of the decimal separator 
in the result character string. 
“,”: Thousands separator 
Example 1: 
Display format: 0.0# 
Value = 1,234 
Output: 1.23 
Example 2: 
Display format: #,##0.00 
Value = 1234,1 
Output: 1,234.10 

Factor Scaling factor for the measurement curve and 
legend. Can be used, for example, to output 
energy values in kW rather than watts. 

Chart preview Displays a preview of the configured chart. 
 
The + and – buttons add or remove values to/from the chart. Click + to add a 
new configuration row. These values can originate from different 
components. This allows the very flexible creation of individual charts. 
Click – to remove the marked measured value row from the chart 
configuration. 
 
The drop-down main menu can be used to discard any changes that have 
been made. To do this, select Charts > Reset chart . RiZone contains 
standard charts for some components (LCPs). They can be restored at any 
time with Charts > Load standard charts . 
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Fig. 29 Chart configuration example 

 
Fig. 22 shows an example configuration for an LCP chart that shows the 
LCP temperature (green), the high temperature warning threshold of the 
LCP (red), the low temperature warning threshold of the LCP (blue) and the 
warning temperature warning threshold of the LCP (orange). 
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9.2 Displaying a chart 

Once the chart has been configured, the chart together with the complete 

project can be loaded to the server (Project > Upload to server or ). 
The chart can also be fetched when the project is performed (Project > 

Start project or ). 

 
Fig. 30 Opening a chart 

 
To do this, right-click in the project tree the (infrastructure) components to 
which the chart was linked for the configuration and select Charts  or Chart 
list . If Chart list  was clicked, the chart must now be selected. 
 
The chart opens in the View window and the values supplied by the 
components to RiZone are shown. 
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Fig. 31 Chart representation for the started project  

 
The elements in the uppermost line of the chart window can be used to set 
the representation interval of the chart.  
1 Interval The time interval of the chart display can 

be selected here (15 minutes, hourly, 
daily, etc.). 

2 
 

Updates and sets the cursor to the 
current value in the chart. 

3 

 

Print - opens the print dialogue for the 
currently displayed chart. The number of 
charts to be printed on each page can be 
specified in the print dialogue. 

4 Time The date and the time when the chart 
display should begin can be specified 
directly here. 

5 Chart selection If several charts were created for the 
component, it is possible to switch 
between the individual charts here. 

6 Legends Moving the mouse cursor over the 
legend entry colours the associated line 
in the chart and the corresponding scale 
on the Y-axis. This permits any easy line 
->scale assignment that simplifies 
reading the chart. 

7 Scroll A double-click on this area scrolls the 
chart forwards or backwards on the time 
window. 
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10 Workflows  

10.1 Operation of the workflows in RiZone 

The workflows in RiZone are used for the automatic processing of 
conditional actions. The actions involve the setting of values using SNMP, 
the sending of e-mails and the parametrised call of external programs. The 
values of the monitored devices collected by RiZone or the variables 
calculated by RiZone can be used for the conditions that determine the 
execution of an action.  
Syntactically correct and fully configured are marked as active when saved. 

 
Fig. 32 Activated workflow in the admin view 

The workflows in the workflow list (admin mode) can be activated or 
deactivated manually with the Activated checkbox. 
Once a project with an active workflow is uploaded to the server, the 
workflow becomes active and will be executed by the server. 
 

  
Fig. 33 Workflow list view mode 

In view mode, the Play/Pause button pauses the processing.  

10.2 Creating a new workflow 

A workflow is always assigned to an infrastructure component (room, 
enclosure suite, etc.). Each workflow, however, always has access to all 
sensor values of the project and not just to the values assigned to "its" 
infrastructure component. 
To create a new workflow, right-click the infrastructure component and select 
Workflow list  in the context menu.  
The overview window for all workflows of the component (workflow list) now 
opens. A right-click on New in the workflow list creates a new workflow. 
Enter a name for the workflow and click OK to confirm. The new workflow 
will now be shown in the list and can be edited. 

10.3 Deleting a workflow 

To delete an existing workflow, right-click the infrastructure component and 
select Workflow list  in the context menu.  
The overview window for all workflows of the component and the logically 
subordinate components now opens.  
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menu. Select Delete  to delete the workflow. 
Click Yes to confirm the delete action. 
The workflow will now be deleted. To also delete the workflow on the server, 
the updated project must first be uploaded to the server (see Upload 
project). 

10.4 Editing a workflow 

To edit a workflow, right-click the infrastructure component and select 
Workflow list  in the context menu.  
Right-click to select the workflow to be edited. The associated context menu 
opens. Select Open . 
The graphical workflow editor now opens. 
The pink frame of the workflow editor window indicates the edit mode. The 
editing is completed with the Workflow > Save workflow  drop-down menu 
(the pink frame vanishes). To return to the edit mode for an open workflow, 
select Workflow > Edit workflow . 
The workflow can now be formed using workflow modules (see Workflow 
modules section). To create a workflow, click the required modules in the 
module bar which then appear immediately on the workflow work surface. 
After the first click on the icon, it appears on the work surface, brought to the 
correct position and released with a left-click. 
A double-click on an icon opens the associated properties menu. The 
properties of the module can then be configured (for details, refer to the 
Workflow modules section).  
If configured modules are clicked, all components whose variables are used 
in the module are marked in the locations tree. 
The view of the workflow desktop can be zoomed with the Ctrl + mouse 
wheel  combination.  
A right-click on the desktop > automatic zoom  sets the desktop so that 
complete workflow is visible. 

10.5 Workflow templates 

 
The RiZone workflow editor provides predefined templates and can be 
extended with customer-specific templates. When a workflow is created, the 
RiZone predefined templates are displayed with the Templates  dropdown 
menu and under Templates  in the Workflow  menu. For the templates, only 
the variables must be replaced and the recipient of the notification selected. 
 
The following workflows are available as templates: 
 

• Redundancy lost Power and Cooling 
• Rackspace 
• Total Weight 
• Alarm Power and Cooling 

 
These workflows are provided for use in conjunction with the capacity 
management. 
 
In addition to the predefined templates, user templates can be created. 
Please proceed as follows: 

1. Open the list of workflow templates (Workflows > Templates ) 
2. Right-click on the list of workflow templates  > New 
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3. The New workflow template  dialogue opens. Enter the name and 
the description of the template, and click OK to confirm.  

4. The Workflow editor now starts. Configure your workflow template. 
Once this has been done, save the template with Workflow > Save . 
The newly create template is now listed when you open the list of 
workflow templates. 

 

10.5.1 Redundancy lost Power and Cooling template  

This template generates an e-mail notification when the configured warning 
thresholds in the capacity management are reached. 

10.5.2 Rackspace template 

This template generates a warning or alarm as e-mail notification when the 
configured warning thresholds are reached. 

10.5.3 Total Weight template  

This template generates a warning or alarm when the configured warning 
thresholds are reached. 

10.5.4 Alarm Power and Cooling template  

This template generates an e-mail notification when the configured alarm 
thresholds in the capacity management are reached. 

10.6  Configuration of the mail server 

The mail server is required for the Send email function of the workflow.  
The mail server is configured in admin mode from the Administration > 
Mail server configuration  menu item. 
 

 
Fig. 34 Mail server configuration 

 

 

Note! 
Workflows in projects created with 
RiZone versions < V3.5 that already 
contain an SMTP configuration in 
Send-Email actions continue to use it. 
If, however, such an old workflow is 
opened and saved again in the GUI,  
the new global SMTP configuration will 
be used in future for this workflow. 
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A workflow consists of various modules (refer to Workflow modules section) 
connected with each other using arrows (directed edges). The arrow 
direction also specifies the flow direction through the workflow. 
During the creation, ensure that: 

1. Just one start symbol exists. 
2. At least one end symbol exists. 
3. All modules have just one successor (= outgoing arrow). The Event 

Gateway and Data Gateway are exceptions. These elements can 
have several successors. 

4. All symbols are connected with each other using arrows. 
5. At least one action must be defined. 

A workflow will be validated for correct syntax before it is saved. The 
workflow must be corrected if the validation fails.  
The error description for the errors on the workflow will be output in the 
message list. 
Otherwise the workflow will only be saved and not switched active when 
uploaded to the server.  
 

10.8 Displaying the description of a workflow element 

With the activation of the description of a workflow element, a permanent 
notice can be displayed in the workflow editor. The description is activated or 
deactivated with a right-click on the workflow element > Display 
description . This permanent notice contains the description of the element. 
 

10.9 Workflow modules 

This section describes the individual workflow modules and their 
configuration capabilities. 

10.9.1 Start event 

 
 

 

Fig. 35 Start event 

The Start event  indicates the starting point of each workflow. It must exist 
just once in each workflow. The properties menu contains the name and the 
unique symbol ID (UID). An individual description of the element can be 
entered in the Description field.  

10.9.2 Stop event 

 
Fig. 36 Stop event 

The Stop event  terminates a workflow. At least one Stop event must exist 
for each workflow. Several Stop events are possible in a workflow. 
The properties menu contains the name and the unique symbol ID (UID). An 
individual description of the element can be entered in the Description field. 
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10.9.3 Condition event 

 
Fig. 37 Condition event 

The Condition event stops the workflow at this point until the set condition 
(e.g. an alarm of a specific sensor) occurs. 
 

 
Fig. 38 Condition event properties 

A double-click on the symbol opens the properties window of the Condition 
event. To configure the condition, proceed as follows: 

1. An individual description of the element can be entered in the 
Description field. 

2. Select the Operator  in the lower window. The Equal operator is 
selected in the figure. Possible operators are: Equal, Unequal, 
Above, Below, AboveOrEqual, BelowOrEqual, And, Or, NAND, 
NOR. 

3. Now select the first operand.  
4. The Type  menu selects whether a constant or a variable is involved. 

If you select a variable, a sensor that supplies the required sensor 
value must then be selected. To do this, left-click the required 
component from the locations or devices view and move with drag & 
drop to the free menu field with the designation Variable . The value 
stored in the database is always used as variable value. Any 
specified display factors are not considered for the comparison 
operations. 
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of all variables supplied by the component. 

6. If you want to enter a constant, select for Type  the Constant  option 
and enter the required value for Value .  

7. Select the value for the second operand and repeat steps 3 to 5 as 
for the first operand. 

 

 

Note! 
Nested operations are possible when 
“And”, “Or”, “Nand ”  or “Nor” is 
selected as operator. 

 
Click Apply  to accept the changes or Reset  to reset all settings. The window 
can be closed by clicking the “Close window” icon at the top right. 

10.9.4 Timer event 

 
Fig. 39 Timer event 

The Timer event stops the workflow at this point until the set time has 
expired. 
A double-click on the icon opens the properties window of the Timer event. 
The time unit (seconds, minutes, hours, days) and the time value can be set 
here.  
 
Example: A delay of 15 seconds should be set 
Unit = seconds 
Time = 15 

10.9.5 Send Email  

 
Fig. 40 Send Email event 

The Send Email event can be used within a workflow to send an email. The 
email will be sent when the workflow reaches the Send Email event.  
A double-click on the icon opens the properties window of the Send Email 
event. 
The following parameters must be configured here: 

• Description: An individual description of the element can be entered 
in the Description field. 

• Recipient: The manual input of an e-mail address as recipient. 
• ToUsers: Select one or more RiZone users as mail recipient. 
• Subject: Subject line  
• Text: Email text 
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10.9.6 Execute Program 

 
Fig. 41 Execute Program event 

The Execute Program event can be used within a workflow to start an 
external program on the server. The program will be started when the 
workflow reaches the Execute Program event. 
A double-click on the icon opens the properties window of the Execute 
Program event. 
The following parameters can be configured here: 
 

• Programme: The programme name, incl. path. Important: The 
programme must be located on the RiZone server rather than on the 
client on which the GUI runs. 

• Arguments: Call parameters for the programme to be started. The 
values and the syntax depend on the programme to be started. 

 

 

Note! 
The programme will be executed on 
the RiZone server under the 
RizoneService user. This means the 
graphical user interface for the 
executed program is not visible. 

 

10.9.7 Set Value 

 
Fig. 42 Set Value event 

The Set Value event sets a value within a workflow using SNMP. This 
requires that the actor has already been integrated in the RiZone project 
using the Discovery function. The value will be set when the workflow 
reaches the Set Value event. 
A double-click on the icon opens the properties window of the Set Value 
event. 
 

 
Fig. 43 Properties of the Set Value event 

 
To configure the setting of a value, proceed as follows: 
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Description field. 

2. Left-click the required component from the locations or devices view 
and move with drag & drop to the free menu field with the 
designation Variable .  
 

 

Note! 
If the Variable field remains empty after 
a device has been added, this device 
does not have any variables that can 
be set.  

 
3. You can then select from the selection menu a settable variable from 

the list of all variables supplied by the component. 
4. Now enter for Value  the value to be set on the actor or select one of 

the states that may be specified. 
Click Apply  to accept the changes or Reset  to reset all settings. Click OK to 
close the window. Cancel  terminates the configuration of the workflow. 

10.9.8 Event Gateway 

 
Fig. 44 Event Gateway 

The Event Gateway is a branch on two or more Condition events. 
Important: The direct successors of an Event Gateway can be only Condition 
events or Timer events (refer to the Event Gateway example figure). 
 

 
Fig. 45 Event Gateway example 
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If, during the processing, the workflow reaches the Event Gateway, the 
workflow will continue at that Condition event whose condition is satisfied 
(true) first. 
 

 

Note! 
This condition is executed just once. 

The condition will be executed again 
only when it reoccurs. 

  

 

Note! 
If no condition is satisfied, a wait will 
be made at the Event Gateway. 

The wait at the Event Gateway 
continues until one of the conditions is 
satisfied. 

10.9.9 Copy Value 

 
Fig. 46 Properties of the Copy Value event 

The Copy Value activity assigns the value of another variable to the variable.  
It is the extension of the Set Value activity for which a constant is assigned 
to a variable. 
Copy Value is used to assign the calculated values to the components, for 
example, via the Workflow engine. 
 

10.9.10 Data Gateway 

 
Fig. 47 Data Gateway 

The Data Gateway is a branch on two or more events. 
The direct successors of a Data Gateway can be all modules except for the 
Start symbol. 
The conditions that determine which path the workflow follows are linked at 
the outgoing edges for the Data Gateway. 
To specify a condition, the properties window of the edge must first be 
opened with a double-click on the edge.  
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Fig. 48 Properties of an outgoing Data Gateway edge 

The condition can now be specified as follows: 
 

1. Select the Operator  in the lower window. The AboveOrEqual 
operator is selected in figure 38. Possible operators are: Equal, 
Unequal, Above, Below, AboveOrEqual, BelowOrEqual, And, 
Or, NAND, NOR . 

2. Now select the first operand.  
3. The Type  menu selects whether a constant or a variable is involved. 

If you select a variable, a component that supplies the required 
sensor value must then be selected. To do this, left-click the 
required component from the locations or devices view and move 
with drag & drop to the free menu field with the designation 
Variable . 
The value stored in the database is always used as variable value. 
Any specified display factors are not considered for the comparison 
operations.  

4. Select from the selection menu a variable from the list of all 
variables supplied by the sensor. 

5. If you want to enter a constant, select for Type  the Constant  option 
and enter the required value for Value  or select one of the states 
that may have been specified. 

6. Select the value for the second operand and repeat steps 3 to 5 as 
for the first operand. 

7. Click Apply  to accept the settings. 
 
The condition for this edge is now configured. 
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Fig. 49 Default Gateway example 

 

Important! 

One edge must be defined as default 
edge. To do this, the value for Type in 
the properties must be changed to 
Default Path.  

If during processing the workflow 
reaches the Data Gateway and no 
condition of any of the outgoing edges 
is satisfied (=true), the workflow will be 
continued at the default edge. 
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11 Maintenance mode 
The maintenance mode indicates that the configuration of a device has 
changed. In this state, the device data can no longer be evaluated in 
RiZone. The maintenance mode can either be set manually with the Service 
variable or activated automatically by the system when certain events occur 
(see Section 11.1). 
The maintenance mode is indicated by a spanner in front of the devices 
icon.  
 

 
Fig. 50 Temperature sensor in maintenance mode 

  
All variables of the affected device change their state: 
Quality = “Bad” 
Quality Detail = “COMPONENT_MAINTENANCE_MODE” 
The maintenance mode causes the variable calculation of the Calculation 
Engine to be delivered automatically with the Quality Bad. No new events 
are initiated by the Quality Bad variable in the Workflow Engine. 
 
There are several possibilities why a device has changed to maintenance 
mode. There are two ways of exiting the maintenance mode:  

• The device changes its configuration back to the original state. In 
this case, the maintenance mode will be deactivated automatically. 

• The device will be rediscovered in the configuration mode and with 
pressed Alt  key moved to the affected device in the project tree. The 
current settings are now accepted as original. 

11.1 Reasons for a maintenance mode 

11.1.1 Changing the temperature unit 

For Rittal CMC devices, the temperature unit can be changed between °C 
and °F. This also changes the values transported via the SNMP interface. 
This situation means the calculated values and limit value tests in a workflow 
are incorrect and the maintenance mode will be activated. If the device 
changes its temperature unit back to the configured state, the maintenance 
mode will be revoked automatically (if the change is made from the website, 
this can take as long as five minutes). Incorrect calculations and workflows 
cannot be excluded during this time. 
The maintenance mode is activated only for those devices that supply a 
temperature value. You can recognise this by them having a “Temperature 
Unit” entry in the properties window. This shows the state present during the 
Discovery. 
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Fig. 51 Properties 

The following devices have this field: 
LCP 
LCP Extend 
LCP Inline 
LCP Inline EC 
LCP Inline CW 
LCP Plus 
LCP Plus EC 
LCP Rack CW 
LCP Smart 
LCP T3+ AC 
LCP T3+ EC 
LCP platform (SK3311.xyz) 
Temperature sensor 
Temperature sensor WL 
CMC III temperature sensor 
CMC III humidity sensor 
CMC III Processing Unit 
CMC III Processing Unit Compact 
RiMatrix S 
 
The Climate Unit does not have this field because the temperature sensor 
exists as an independent device. 
 

 

Note! 
If a Rittal device supported by RiZone has 
at least one temperature variable, the 
“Temperature Unit” property also exists. 
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11.1.2 Changing the hardware configuration 

The possible changes are listed in the properties of the LCPs. 
  

  
Fig. 52 Properties 

These properties are assigned to the device during the Discovery. If these 
no longer match those of the device, a switch is made to maintenance mode. 
The maintenance mode will be exited when the old state is restored. If the 
device with the changes is to be accepted, it must be deleted from the 
project and a new discovery performed. Alternatively, it can be moved with 
pressed Alt  key to the existing component and so updated.  
  
The following devices have these fields: 
LCP Inline / Water Sensor / Flowmeter / Control valve 
LCP Inline EC / Water Sensor / Flowmeter / Control valve 
LCP Inline CW / Water Sensor / Flowmeter / Control valve 
LCP Plus / Water Sensor / Flowmeter / Control valve 
LCP Plus EC / Water Sensor / Flowmeter / Control valve 
LCP Rack CW / Water Sensor / Flowmeter / Control valve 
LCP Smart / Water Sensor / Flowmeter / Control valve / Condensation 

pump 
LCP Standard / Fan Module 1 / Fan Module 2 / Fan Module 3 / Water 

Module  

11.1.3 Configuration Changed 

If a device (PU, LCP, etc.) enters the “Configuration Changed” mode, this 
device will be set into the maintenance mode. 
The following procedure must be adopted to return the device to the active  
mode: 

1. Acknowledge the “Configuration changed” status on the Processing 
Unit. 

2. The component must be updated in the project. To do this, perform the 
discovery of the component again and with pressed Alt  key use drag & 
drop to move the newly discovered device to the component already 
present in the project. This updates the data for this component in the 
project. 

3. Components that no longer exist must be deleted from the project. 
4. Finally, upload the updated project to the server. 
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Important! 

A reorganisation of the device branch 
for a CMC III PU can cause a change of 
the OIDs of the connected 
components. A new discovery and 
update must be performed in RiZone. 

 

11.1.4 Service variable 

Devices and infrastructure components that possess the Service  variable can 
be placed into the maintenance mode by setting the variable to the 
Maintenance  value. To exit the maintenance mode again, either the Service  
variable can be set to active  or the project uploaded to the server again. 
 

 

Important! 

If an infrastructure component (e.g. 
rack suite) or a device with 
subordinate components (e.g. PU with 
multiple sensors) is placed into the 
maintenance mode, all subordinate 
components/sensors will also be 
automatically placed into the 
maintenance mode. 

To return all components to the 
“active” mode, the Service variable of 
all subcomponents/sensors must be 
individually set to “active” again. 
As an alternative, the complete project 
can be uploaded to the server again. 
This also sets the components back to 
“active”. 
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12 Message list 
RiZone has a message list that contains all messages of the RiZone server. 
The messages have various categories, owners and states. Each message 
has a unique timestamp and owner. The message description explains the 
message. Moving the mouse over the message displays the description of 
the message as Tooltip. 
The message list differentiates between current messages  and finalised 
messages . Finalised messages are current messages whose status  has 
been set manually to Terminate.  To set the Terminate status, the message 
must be opened with a double-click. The status then can be changed from 
the drop-down field. The time interval for which messages are displayed can 
be restricted. The restrictions are: 
All, 1 hour, 1 day, 1 week. 
All messages for specific categories can be filtered. The categories are: 
Errors, Warnings, Information and OK. 
The filtering applies to the displayed messages rather than all messages in 
the database. 
The arrow keys navigate through the message list. A right-click  opens the 
context menu. A double-click  opens the properties window of the message. 
The message list also has a function for grouping messages. In this case, 
the messages are grouped in the message window according to sensor 
status or event. The grouping can be activated and deactivated with the 
Grouping  button. 

12.1 Process 

The process assigns the message. The following processes are 
differentiated: 

12.1.1 Monitoring 

The messages grouped in the Monitoring process apply to the active area of 
RiZone. 

12.1.2 System 

The messages grouped in the System process are system messages.  

12.1.3 Workflow 

The messages of the Workflow process are those messages issued while 
uploading a project when one or more workflows were created in a project. 

12.1.4 Calculation 

The messages of the Calculation process are those messages issued while 
uploading a project when one or more calculations were created in a project. 

12.1.5 Discovery 

The messages of the Discovery process provide information about the 
devices found during the discovery process. If RiZone does not support a 
firmware, an error message will be issued during the Discovery process. 

12.2 Owner 

The owner of a message is the component ID for RiZone. This can be a 
device, a workflow or a calculation. 
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12.3 Status 

The status of a message indicates the processing status of a message. 

12.3.1 None 

The None  status specifies that the message has not yet been accepted by 
any user in RiZone. The message is not yet processed. 

12.3.2 Commit 

The Commit  status specifies that the message has been accepted by a user 
in RiZone. The message is not yet processed. 

12.3.3 Confirm 

The Confirm  status indicates that the message from a user in 
RiZone has been confirmed. The message is not yet processed. 

12.3.4 Work On 

The Work On  status specifies that the message has been accepted by a 
user in RiZone. The message is being processed. 

12.3.5 Terminate 

The Terminate  status specifies that the message has been accepted by a 
user in RiZone. The message is completed. 
Messages with the Terminate  status can be viewed only from the Finalised 
messages  tab.  

12.4 Properties 

A double-click on a message opens the properties window. The detailed 
message is displayed in the properties window. It is possible to change the 
status and add a comment to the message. The user who accepted the 
message is logged. 
A history of the messages is saved. 
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13 Report 
RiZone provides the capability to generate a report for the variables 
associated with a node. This report can be executed cyclically and 
downloaded from the server to the client PC. The access control for a report 
is controlled in the user administration. 

13.1 Creating a report 

A report can be created for any component of the RiZone project. The 
Report  function in admin mode opens the configuration window in the GUI. 
The New function creates a new report. 
 

 
Fig. 53 Creating a report 

13.1.1 Selecting variables 

The variables are selected with a mouse click in the window. Ctrl  and click  
select more than one item. Shift and click  select a group of variables. The 
marked variables have a blue background. Click the >> double-arrow to 
transfer the variables to the selection window. The selection of the variable 
and the click on the << double-arrow deselects the variable. 
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13.1.2 Name/description 

The name of a report is a mandatory field and preassigned. Only digits, 
alphabetic characters and the underscore are permitted for a name. 
Accented characters are not supported. The name of a report may not begin 
with a digit. The maximum length of the name is 50 characters. 
 
The report description is optional. The maximum length is 256 characters. 

13.1.3 Cycle 

The regular execution of the report is configured in the cycle selection 
window. Never  specifies that no report will be created. 

13.1.4 Saving a report 

A report is saved by selecting the Reports  tab in the menu and then clicking 
Save. The report will be saved under the selected node. The changes take 
effect on the RiZone server only when the project has once again been 
uploaded to the server. 

13.2 Deleting a report 

A report can have been created at any node of the RiZone project. The 
Report  function in admin mode opens the configuration window in the GUI. 
A list of the reports present for the node is displayed. Click Delete  to delete 
the associated report. Confirm the prompt with Shift and click.  

13.3 Downloading a report 

A report can be downloaded in the view mode of the GUI. The logged-in 
user must have the appropriate authorisations. The report has CSV format. 
The reports are saved in the ~\My Documents\RiZone\Reports  directory. 
The report is downloaded by selecting the appropriate report and then 
selecting the Synchronise  function. The Reports >  Synchronise all  option 
in the drop-down menu downloads all versions of the report.  
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14 User administration 
The RiZone user administration is based on the user administration of the 
RiZone Appliance operating system. The membership of the RiZone 
Appliance in the directory service integrates the user administration in a 
directory service.  

14.1 Creating a user with the GUI 

A new RiZone user is created from the Administration > User 
administration > Users > Create user  menu. The user is created as local 
user on the RiZone Appliance. The user name must consist of at least five 
characters, and the password requires a minimum length of seven 
characters, including one special character. The assignment of the e-mail 
address must be unique: An e-mail address can be entered only for one 
user. The e-mail address may be used later in the Send EMail  > ToUsers  
workflow element.   
All fields are mandatory for creating a user. The activation of the Enable 
user?  checkbox activates the user. 
 

 

Note! 
A user must be activated in order to 
log in to the RiZone server. 

Activate the user during the creation. 

 

14.2 Changing a user account 

A user account is changed from the Administration > User administration 
> Users  menu. Select the user with a double-click. 
The e-mail address and the comment for the user can be changed in the 
Change details  menu item.  
The Change password  menu item changes the password. 
The Administer roles  menu assigns the user to one or several roles. 
The Delete  user account  menu item deletes the selected user. 
The Deactivate user account  function deactivates the user. The user can 
then no longer log in to RiZone. All user settings, however, are retained. 
The Activate user account  function activates the user. 
Administer other user accounts  returns to the user selection. 

14.3 Creating a role with the GUI 

A new RiZone role is created from the Administration > User 
administration > Roles > Create new role  menu. The role is created as 
local group on the RiZone Appliance. The group name must begin with 
RiZone. 
 

 

Note! 
Role names cannot be changed later! 

14.4 Assigning a user to a role 

The Change user account > Administer roles  menu assigns the user to 
one or several roles. 
This is also possible by selecting the appropriate role and assigning the user 
to the role in the Roles  menu. 
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14.5 Removing a user from a role 

The Change user account > Administer roles  menu removes the user 
from a role. 
This is also possible by selecting the appropriate role in the Roles  menu and 
removing the user from the role. 

14.6 Deleting a user with the GUI 

The Delete  user account  menu item deletes the selected user. 

14.7 Deleting a role with the GUI 

To delete a role, proceed as follows: 
• Select the Role  tab 
• Double-click the role to be deleted 
• Click Delete role  
• Confirm the prompt 

The role will now be deleted. 

14.8 Configuring RiZone in a directory service 

RiZone is integrated in a directory service by the membership of groups of 
the directory service in the local groups of the RiZone server that were 
created as role with the RiZone GUI. 
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15 Capacity management 
The RiZone capacity management allows a transparent monitoring of the 
energy supply, cooling, available height units and loading of the server 
enclosures. The location components are configured with the planned values 
of the data centre and an automated calculation of the currently installed 
inventory performed. 
 
Caution: When the capacity management is deployed, all location 
components must be configured because otherwise the status information 
may be incorrect. 
 
The IT load is calculated automatically on the enclosure component when 
PSM busbars or PDUs have been configured by Rittal. The IT load on the 
other location components is calculated automatically by upwards 
inheritance in the hierarchy. 
 

15.1 Configuring the location components 

Each location component must be configured for the deployment of the 
capacity management. A multiple selection for the same infrastructure 
components is possible. The percentage values always apply to 100%. 
 
Example: The status alarm of the IT load should be initiated at 8 kW 
because the maximum redundant load lies at 10 kW. 
For a redundant infeed of 10 kW per enclosure, the maximum IT load that 
can be provided electrically is 20 kW. The planned IT load should not exceed 
80% of the redundant load. The planned value for the IT load must be 
configured with 8 kW. The threshold value for the warning does not need to 
be edited. An alarm should be issued when no further redundancy exists. 
The alarm value must be adapted accordingly to 25%.  
The status alarm is generated at 125% of 8 kW -> 10 kW. 
 

 

Note! 
If the warning and alarm threshold 
values are set to 0, no alarming RiZone 
occurs. Also for cases in which the 
capacity management should not be 
used, all warning and alarm threshold 
values must be set to 0. 
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Fig. 54 Capacity management component properties 

 

15.2 Variables 

The variables of the capacity management belong to the standard variables 
of each infrastructure component. The calculations are performed 
automatically based on the properties of the infrastructure component as 
well as the information from DRC, PSM, PDU and the rack items. The 
deployment of power distribution components not supported by native 
RiZone requires that the calculations for the IT load are configured manually. 
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Fig. 55 Capacity management variables of the infrastructure components (here enclosure) 

 
AvailableCoolingCapacity The available cooling capacity of the 

infrastructure component (IC). The difference 
of maximum cooling capacity and the 
currently required cooling capacity of the IC 
specified for the component properties. 

RequiredCoolingCapacity The cooling capacity that the installed 
components require currently (corresponds to 
the power consumption of the IT 
components). 

MaxCoolingCapacity_Status Status of the maximum cooling capacity. Limit 
values are configured for the properties of the 
IC. 

AvailableUs Available height units (Us) of the 
components. 
The assignment is calculated using the U 
entries of the enclosure elements.  

UsedUs Assigned height units of the components. 
The assignment is calculated using the U 
entries of the enclosure elements. Entered 
blank panels belong to the assigned Us. 

UsedUs_Status Status of the height units. Limit values are 
configured for the properties of the IC.  

MaximumNoOfConnected 
UseableUs 

Number of height units that form the largest 
free installation field in the IC. 

TotalWeight Current weight of the IC, including installed 
components. 
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MaxTotalWeight_Status Status of the maximum weight of the IC. Limit 
values are configured for the properties of the 
IC. 

ActualITLoad Current electrical load of the devices in the 
IC. The value is calculated automatically for 
the deployment of Rittal PDU or PSM power 
busbars with measurement. For the 
deployment of third-party devices, 
ActualITLoad must be calculated manually by 
calculating variables (Section 7.14). If this is 
changed again to an automatic calculation 
(prerequisite: deployment of Rittal PDU/PSM 
busbars), the variable calculation for 
ActualITLoad must be opened and all 
calculation steps removed. The ActualITLoad 
is calculated automatically once the changes 
have been saved and the project loaded onto 
the server.  

AvailableITLoad The free electrical power still available to the 
IC devices. Limit values are configured for the 
properties of the IC.   

MaxITLoad_Status Status of the maximum electrical load of the 
IC devices. 

NoOfDevices Number of devices installed in the IC. This 
also includes blank panels. 

 
 

15.3 Charts 

The capacity management has a default chart that uses a speedometer to 
represent the IT load utilisation, the available cooling capacity, the available 
height units and the possible loading of the location component. 
 
 

 

Note! 
If the planned values are set to 0, no 
speedometer display is made in the 
charts. 

If the warning and alarm threshold 
values are set to 0, the speedometer is 
displayed without a warning and alarm 
area.  
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16 Assigning rights for RiZone components 
Rights are assigned in a project at the component level in the project tree. 
The component rights are assigned to a RiZone role. This role is assigned to 
a user group of the operating system. Rights can be assigned in the 
locations tree and in the devices tree. 

16.1 The rights concept for RiZone 

RiZone has seven different authorisations. These authorisations can be 
used for just one component or can be inherited. The inheritance permits all 
subordinate components of the selected reference tree to be given the same 
rights.  

16.2 RiZone rights 

16.2.1 Read 

The read  right permits read access to the component. No changes can be 
made to the component. 

16.2.2 Setting 

The setting  right permits the change of threshold values. 

16.2.3 Configuration 

The configuration  right permits the change of a component. This permits 
the change of the component name or the change of the SNMP 
configuration. Specific LCP settings are also assigned to the "Configuration" 
group (some parameters from LCP Standard and Extend). 

16.2.4 Execute 

The execute  right permits the switching of the outputs of a device that has a 
switching function. 

16.2.5 Charts 

The charts  right permits the display of a chart. The chart must be created by 
an administrator. 

16.2.6 Workflows 

The workflows  right permits the display of a workflow. The workflow must 
be created by an administrator. 

16.2.7 Reports 

The reports  right permits the download of a report. The report must be 
created by an administrator. 

16.3 Changing an authorisation in the object tree 

The rights are assigned for a component in the properties window. The 
properties window is opened with a right-click  on the component icon and 
the selection of properties . The properties window opens in the GUI main 
window. The selection of the Rights  tab opens the rights administration . 
The Reference tree  drop-down menu is used to select in which project tree 
the rights assignment is made. The Subordinate components ...  checkbox 
permits the inheritance of rights below the component. 
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It is possible to assign a role to each individual right. Multiple selection is 
possible. 
The changes take effect only after the upload of the project. 

16.4 Setting variables for the external application via SNMP 

To allow variables for external systems to be set in RiZone via SNMP, the 
following steps must be performed. 

• The variable to be set must be set to publish . 
• The RiZone3rdParty standard role must be entered in the rights 

assignment of the component or the sensor under setting, execute or 
configuration (depending on the application). 

 
Each external application known to the SNMP read- and write-community 
can now set such configured variables externally. SNMP user and SNMP 
password are also required for SNMP v3.  

17 Searching for variables and components 
The search for RiZone is possible in view and admin mode. The search is 
called from the Edit> Search  menu or with the “Ctrl+F” key combination. A 
search can be made for variables or components. Multiple search criteria 
can be combined with an “And operation". 
 
The search for components also allows the search for infrastructure 
variables of the capacity management. A search can be made for the 
following capacity variables: 
Available Us Number of available height units of 

an infrastructure component (IC). 
Consecutive usable Us Maximum number of consecutive 

height units of an IC. 
Available IT load Available free electrical load of an IC.  
Current IT load The currently used electrical load of 

an IC. 
 
The input of an operator and a value completes the search request. 
To create more complex queries, further criteria can be added with the +Add 
criterion  button.   
 
The results in the variable or component branch are shown in the results 
window. A double-click on the displayed component or variable opens the 
variables view in the RiZone GUI. 

18 Relocating a tab as a single window 
When several monitors are used, it can be desirable to relocate the 
individual tabs of the RiZone GUI to another monitor. This is done with a 
click on the Relocate tab  icon. 
This function is possible only in view mode. 
 

 
Fig. 56 Close tab button 
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the GUI. 
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19 Setting values 

19.1 Setting the values of a component from the user 

interface 

The RiZone user interface serves not only for querying of data using SNMP, 
values such as thresholds for temperature sensors can also be set. This 
function is available only in view mode and the logged-in user requires the 
necessary authorisations. 
To set or change a value, proceed as follows: 

• Right-click to select the component/sensor in the project tree and 
select Variables in the context menu. The variable view of the 
component now opens in the View window. 

 
• Now click the Set button after the variable value in the View window 

that you want to change.  

 
• You can change the value either by the direct input of the value or 

using the slider in the Set value  window that now opens. The slider 
specifies the permitted value range. 
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If only specific values are permitted, a drop-down menu lists all 
possible inputs. 

• After changing the value, click the Set button to transfer the value to 
the component. 

• Once the value has been written successfully, it will be displayed 
immediately in the View window. 
 

 
 

 

 

Note! 

To set one or more values, the IP of the RiZone 
server must be entered as trap receiver in the 
component (e.g. CMC Processing Unit II). If this 
is not the case, the component does not accept 
any values from the RiZone server. 

 

 

Note! 

If the value cannot be set, an error message will 
indicate this situation. In this case, the value 
must be reset and Set clicked to reinitiate the 
action. 
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19.2 Setting several values simultaneously 

In addition to the setting of individual values, the RiZone user interface can 
also be used to change several values simultaneously.  
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select Variables in the context menu. The variable view of the 
component now opens in the View window. 
 

 
 

• Now select in the View window all values that are to be changed 
simultaneously. To do this, click successively all variables to be 
changed while keeping the Ctrl  key pressed. It is also possible to 
mark an area by pressing the Shift  key. 
 

 
 
• Now click the Set button for one of the selected variables.  
• The Set value  dialogue for several values opens. 
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• To set values simultaneously, the selection box in front of each 
selected variable must be set. 

 
• Now enter the value to be used for all selected variables as New 

value  and click Set value  to confirm. 
 
 
 

 

Caution! 
Only the same variable types can be set with a 
multiple selection. 

Select the same variable types, such as 
VoltageCxPx_SetLow 

 
• Once the values have been written successfully, they will be 

displayed immediately in the View window. 
 

 
 
 
 

 

Note! 

If the trap receiver is not configured on the 
RiZone Server for the PU, the changes will be 
transferred to the RiZone Server after five 
minutes at the latest. If the change should be 
made faster, the PU must be rediscovered and 
replaced in the project tree. 
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20 Configuration of the SNMP devices 
The SNMP devices are configured during the configuration and in the 
running project. During the configuration, the variables of the discovered 
devices are configured. 
The SNMP communication will be activated when the project is started. If the 
project has been started, the individual devices can be configured. 

20.1 Configuration of variables 

In addition to the SNMP-polled variables, variables can also be created 
manually. Their value can be calculated using arithmetic operations for 
polled or other manually-created variables. This makes it possible, for 
example, to create a variable that calculates the total power consumption of 
a rack when the individual values are fetched in RiZone with SNMP polling. 
For the configuration of a variable, the GUI must be in admin mode and an 
infrastructure component (e.g. rack) in the project tree selected. A right-click 
on the variable opens the context menu. The Variables  option will be 
selected. The variables window of the selected component opens in the 
main window (View window) of the RiZone GUI. If required, click Down 
arrow  to open the variables list. 
 

 

Fig. 57 Configuration of variables 

The mouse can now be used to select a variable. A right-click opens the 
context menu.  
The New variable  menu item creates a new variable at the infrastructure 
component level. 
The Edit variable  menu item permits the configuration of the automatically 
discovered variables of a Rittal component.  
The Shift  and Ctrl  keys can be used to select multiple variables. Only the 
selected field is refreshed for a multiple selection. All other fields remain 
unchanged. 
The following variables can be configured for the configuration: 
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• Interval 
• Group 
• Description 
• Publish (the value of the variable is published via SNMP, i.e. a 

higher-level management system can query this value from RiZone 
via SNMP) 

To ensure correct operation, no other settings may be changed. 
 
Ways of entering a variable 
Name Name of the variable. 
Description Description of the variable. 
Type Float  and StatusInt  are possible as variable type. 

Float is used when a (float) numeric value is stored in 
the variable, StatusInt for status variables. 
Important note:  The variable type can be selected 
only when the variable is created. A subsequent 
change is not possible. 

Publish If set, the variable will be passed to the Messaging 
Service. The variable can now be fetched via SNMP 
by a different system. 

Write access If the option is activated, the variable can be set via 
RiZone (Set button). It may be activated only when 
this variable can be written on the device side via 
SNMP. 

Interval Specifies the refresh cycle (in seconds). Off  means 
that the variable will be refreshed once after the 
project is uploaded. 

Meaning Meaning of the variable (Undefined, State, Value, 
Setting, Configuration, Service, Execute). 

Phys. 
measurement 
quantity 

Specifies the measurement quantity of the variable. 

Unit Specifies the unit of the variable. 
Min/Max Specifies the minimum and maximum value that the 

variable can assume. 
Display factor Display factor of the variable. 
Display format Defines the numeric format with which the value is 

displayed: 
“0”: Replaces the digit 0 with the specified digit (if 
present), otherwise the digit 0 is displayed on the 
result character string. 
“#”: Replaces the “#” symbol with the specified digit (if 
present), otherwise no digit is displayed on the result 
character string. 
“.”: Specifies the position of the decimal separator in 
the result character string. 
“,”: Thousands separator 
Example 1: 
Display format: 0.0# 
Value = 1,234 
Output: 1.23 
Example 2: 
Display format: #,##0.00 
Value = 1234,1 
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Group Selection of the group of the variable. 

The selection of the group affects the group status 
variables of the component to which the variable in 
the project is assigned. If the variable is assigned to a 
group and changes its status, the group status 
variable of the higher-level infrastructure component 
also changes its status on the variable (exception: the 
status of the group status variable has already been 
raised to a more critical status by a different variable). 

 
  

 
Fig. 58 Changing of variables 

 

20.2 Configuration of SNMP devices 

The SNMP devices are configured in the running project; the logged-in user 
must have the appropriate rights. A device is selected in the project tree. A 
right-click on the selected component opens the associated context menu. 
The Variable  menu item can now be selected. The variables list of the 
component opens in the RiZone GUI main window. 

20.2.1 Component name 

The component name is configured by selecting Name and clicking the Set 
button. Ensure that the name of the component is not longer than the 
maximum character length. Observe the operating instructions of the 
component used. 
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Fig. 59 Name of the component 

 

 
Fig. 60 Component name value input 
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20.2.2 Location name 

The location name is configured by selecting Location  and clicking the Set 
button. Ensure that the name of the location is not longer than the maximum 
character length. Observe the operating instructions of the component used. 

 
Fig. 61 Location name 

 
 

 
Fig. 62 Location name value input 
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20.2.3 Contact name 

The contact name is configured by selecting Contact  and clicking the Set 
button. Ensure that the name of the contact is not longer than the maximum 
character length. Observe the operating instructions of the component used. 
 

 
Fig. 63 Contact name 

 

 
Fig. 64 Contact name value input 
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20.2.4 Quit 

The Quit function permits the automatic acknowledgement of a message and 
the confirmation of configuration changes for the CMC-TC system. The Set 
button enables and disables the function.  
The “Quit” , “No quit”  and “Restart”  (only CMC-TC) functions can be 
selected. 
Quit : The message will be acknowledged. 
No quit : The message will not be acknowledged. 
Restart : The Processing Unit will be rebooted (only CMC-TC). 

 
Observe the operating instructions of the component used. 
 

 
Fig. 65 Activating the Quit function 
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20.2.5 Trap enable 1-16 

The Trap enable  function activates/deactivates the trap receiver. The Set 
button enables and disables the function. Observe the operating instructions 
of the component used. 
 

 
Fig. 66 Trap enable function  

 

 
Fig. 67 Trap enable value selection 
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20.2.6 Trap receiver 1-16 

The Trap receiver  function configures the trap receiver. The Set button 
configures the IP address of the trap receiver. Observe the operating 
instructions of the component used. 
 

 
Fig. 68 Configuring the trap receiver 

 

 
Fig. 69 Entering the IP address of the trap receiver 
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20.2.7 Configuring a value 

The Set button is used to set a value. Observe the operating instructions of 
the component used. 
 

 
Fig. 70 Setting values (general) 
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21 Replacing a device 
RiZone allows the replacement of a device in the project tree without 
changing the configured properties. Ensure that the device type and the 
configuration of the devices are identical. 
Procedure: 

• Selection of the new device 
Left-click  the device to mark it in the Discovery  window. 

• Moving the device into the project tree 
Drag the device with pressed Alt  key to the device to be replaced. 
Before the component is replaced, a prompt is issued whether the 
names and setting values of the old components should be 
transferred to the new component. If the new component serves as 
replacement for the old component, click Yes to confirm the 
dialogue.  

22 Configuring the communications modules 
To increase the capability of RiZone for projects with a larger number of IP 
nodes (>150 IP nodes), a second communications module can be started on 
the server. The configuration options can be accessed from the 
Administration > Configure communications module  menu item. 
 

 
Fig. 71 Configuring the communications module 

1 Tab for Communications module 1 configuration 
2 Tab for Communications module 2 configuration 
 

Active The corresponding module is active when the 
checkbox is activated. 
Note:  The first communications module is the master 
module and cannot be deactivated. 

Start IP The start of the IP range that the communications 
module queries using the SNMP protocol. 

Stop IP The end of the IP range that the communications 
module queries using the SNMP protocol. 

 
The communications module 1 is automatically active after the installation of 
RiZone. 
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To activate the second module, the “active” checkbox must be activated for 
communications module 2 and the IP range to be queried entered 
(Start/Stop IP). 
If the second module is activated, a second communications module service 
will be started automatically on the server. 
 

 

Note! 
To ensure that all IP addresses are 
monitored, enter the monitored address 
ranges. 
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23 Configuring the database connection 
RiZone saves all fetched and calculated data automatically in an SQL 
database. The supplied system contains an MS SQL Express database that 
fully suffices for smaller projects and permits the saving of data for several 
months (depending on the number and type of the IP nodes). 
For mid-sized and larger projects with more than 50 IP nodes or for projects 
in which mainly SNMP devices are deployed that supply many values (e.g. 
PSM busbars with measurement, LCP, etc.), it is desirable to connect 
RiZone to an external database with larger storage capacity. 
 

 
Fig. 72 Configuring the database connection 

The following parameters can be set in the configurations tab (Fig. 72 
Configuring the database connection): 

Server type The server type.  
MSSQL Express  (default setting, database is 
supplied) 
MSSQL   
Oracle  

Server name The name or IP address of the database server 
(default: local). 

Instance name The name of the database instance (default: 
SQLEXPRESS). 

Database name The name of the database. 
User name The user name for the database access. If a 

specific user should access the database, the 
user name must be entered here. 

Password Enter the password that belongs to the user 
name. 

The days after which 
messages are 
discarded 

The number of days after which messages 
(message list) are deleted from the database. 

The days after which 
values are discarded  

The number of days after which values are 
deleted from the database. 

 
If RiZone should access an external MSSQL database (MSSQL option), the 
access rights can be represented with two variants.  
 
Variant 1: Creation and operation of the database with DB owner 
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RiZone requires for creation of the databases the membership of the 
database user in the public and dbcreator SQL Server roles. For normal 
operation, after the successful creation of the databases, the dbcreator role 
can be revoked again. 
 
Variant 2: Creation and operation of the database with separate users 
The user for creating the databases must have the authorisation as for 
Variant 1. After the successful creation of the databases, the connection 
configuration can be changed to a separate user for operation. This user 
requires the following authorisations on all RiZone databases: EXECUTE 
and ALTER, as well as the membership in the database roles db_datareader 
and db_datawriter. 
 
 

 

Note! 
When Oracle is deployed, the required 
database entered in the configurations 
tab must have been created on the 
Oracle database server prior to the 
start of RiZone. Otherwise RiZone 
cannot establish any connection to the 
database. 

 

24 Updating the RiZone driver 
The Administration > Update device driver  function updates the RiZone 
device driver. 
If necessary, updated drivers will be made available as DLL file on our 
www.rimatrix5.com website or from our support. 
To install the driver, proceed as follows: 

1. Click Administration > Update device driver  in the opened RiZone 
client. A file selection window now opens. 

2. In the file selection window, change to the folder in which you stored 
the DLL file. Select the DLL file and click Open . 

3. A window opens with the transfer status. Once the transfer has 
completed, click OK to confirm the action. 

This completes the update and the driver will be updated. 
 
After a driver has been updated, those devices previously discovered with 
the old driver must be rediscovered and moved to the project. 
If the transfer status from item 3 reports an error: Note that only DLLs 
provided by Rittal are suitable for update. RiZone does not accept other DLL 
files. 
 

25 Reconnecting the client with the server 
If the RiZone client loses the connection to the server, the Administration > 
reconnect  menu item re-establishes the connection. The RiZone client is 
then in the same mode (admin/view) as for the connection termination. 
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26 Downloading the log files 
The RiZone logs all user and system actions in the appropriate log files. In 
addition, all actions of the RiZone services (Core, Communication, Workflow, 
Calculation, Messages, Monitoring) are logged.  
To download the log files to the local computer, select the Administration > 
Download log files  function in the view mode of the client. 
 

 
Fig. 73 Downloading the log files 

Select the date of the required log files and click OK to confirm. In the 
subsequent Save as  dialogue specify the storage location and the file name 
of the Zip file. Click OK to save the ZIP file in the selected folder. 
 
UserAction 
This log file records all actions that the users made (login, mode change, set 
commands, etc.). 
 
System  
This log file records all actions that the RiZone or RiZone modules have 
performed. 
 
Maintenance 
This log file records when a device or sensor switches to maintenance 
mode. 
 
 
RiZone services logs 
Separate log files for the Core, Communication, Workflow, Calculation, 
Messages and Monitoring services. 
 
The GUI log file is not present here. The GUI log file is always stored on the 
folder on which the GUI is executed and is located under \RiZone\logs in the 
document directory of the active user. 
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27 Messaging service  
With the messaging service, RiZone offers the capability to transfer not only 
the status of components but also individual, published variables to a higher-
level network management system with the SNMP and OPC-UA protocols. 
RiZone variables can also be set by external SNMP management systems 
via SNMP. 
The status of a component is forwarded automatically to the messaging 
service and does not need to be configured separately. 

27.1 Configuring a variable for the messaging service 

During the creation or editing of a project, the Publish  checkbox can be 
activated for the editing of a variable. If this checkbox is activated, the 
variable will be passed to the messaging service. If variables should be set 
by external systems via SNMP, the rights that belong to the variable must be 
adapted appropriately. For details, consult Section 16.4.  
To activate the changes, the changed project must be uploaded to the 
RiZone server. 

27.2 SNMP configuration 

The SNMP agent  tab is selected in the Administration > Messaging 
service  menu. The Activate SNMP agent  checkbox activates the service 
for connection to a network management system. 
The Reinitialise SNMP agent  checkbox re-establishes the dynamic MIB for 
RiZone. This function deletes the OID in the MIB when a variable is no 
longer published. 
If the MIB is re-established, this can lead to integration incompatibilities of 
RiZone in the network management system. 

27.2.1 Network 

The Network  menu assigns the rights for the SNMP access. The SNMP 
version specifies whether RiZone can be queried via SNMPv1 or SNMPv3 
provided the SNMP agent has been activated (Section 27.2). 
The configuration for the Read community  and Write community controls 
this authorisation for SNMPv1.  
For SNMPv3, the user name and the password must be specified.  
These settings must be identical with those in the management system.  
The access from arbitrary management systems via SNMPv1 can be 
permitted when the Read and Write community fields are empty. 

27.2.2 MIB-II 

Settings are made in the MIB-II menu to identify the RiZone server using 
SNMP. 
SysName : SNMP name of the RiZone server 
SysLocation : Location of the RiZone server 
SysContact : System officer 

27.2.3 Trap 

RiZone supports a maximum of two trap recipients. These can be configured 
as Trap recipient 1  and Trap recipient 2 .  
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27.3 Specification of the MIB 

 

Fig. 74 Example representation of an MIB 

 
mgmt.mib-2.system  – data for identifying the computer. In accordance with 
the MIB specification, some data can be written. For deviations between the 
SNMP agent and the setting dialogue, the dialogue data is used (to view the 
changes in the setting dialogue, the dialogue must be closed and re-
opened). 
private.enterprises.rittal.riZone.rizoneMibRev  – version details of the 
used MIB, currently 1.2.  
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private.enterprises.rittal.riZone.rizoneMibRev.riZo neMibCondition – 
status of the complete system 
other (1), 
ok (2), 
degraded (3), 
failed (4), 
configChanged (5) 
private.enterprises.rittal.riZone.rizoneMibRev.riZo neModule  – status 
and version of the installed RiZone server 
private.enterprises.rittal.riZone.rizoneMibRev.riZo neProject  – project 
name and timestamp of the last change 
private.enterprises.rittal.riZone.rizoneMibRev.riZo neStatus  – status of 
the components and variables contained in RiZone. The overall status of the 
project can also be queried specifically. This corresponds to the status of the 
uppermost project node. 
  
Component table 
All RiZone components are always available in the component list. 

 Fig. 75 Components table 

Component Index –table index 
Component Id – RiZone ID of the component 
Component Name  – RiZone component name 
Component Type  – 
removed (1), 
domain (2), – line is no longer used 
location (3), 
building (4), 
room (5), 
rackrow (6), 
rack (7), 
device (8), – component represented by a driver (CMC, LCP, UPS ...) 
Rack Item (9) 
  
Component Parent  – ID of the higher-level component in the RiZone 
locations tree 
Component Status Total  – overall status of Availability, Cooling, Power, 
Monitoring, Rack, Capacity and Security  
  
Variables table  
The variables list contains all variables that have activated the Publish  
option in the properties. 

  
Fig. 76 Variables table 
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Note! 

The table will be updated when the “Reinitialise 
SNMP agent” function has been executed. If the 
function is not called, values may remain in the 
table that are no longer present in the RiZone 
project or should no longer be published. 

 
Variable Index – table index 
Variable ID  – RiZone ID of the variable 
Variable Name  – name from the RiZone variable list 
Variable Maintenance Group  – specifies to which group the status belongs. 
This is a bit-coded field. 
undefined(1), 
cooling(2), 
power(4), 
rack(8), 
monitoring(16), 
remoting(32), 
availability(64), 
security(128), 
capacity (256)  
Variable Unit  – specifies the physical measurement unit. This does not 
determine the factor (mW, W, KW). 
undefined(1), 
temperature(2), 
current(3), 
power(4), 
effectivePower(5), 
humidity(6), 
voltage(7), 
energy(8), 
frequency(9), 
access(10), 
leakage(11), 
percent(12), 
rpm(13), 
co2(14), 
pue(15), 
flow(16), 
time(17), 
costs(18), 
imp(19) 
heatCapacity(20) 
constant(21) 
temperatureDiff(22) 
timespan(23) 
pulseRate(34) 
cycles(24), 
pressure(35), 
acceleration(36), 
timeSpanTicks(37) 
Variable Parent ID  – RiZone ID of the component to which the variable is 
assigned. 
Variable Type  – specifies the data type. 
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number(1), 
string(2), 
enum(3) 
Variable Quality  – validity of the measured value. 
undefine(1), – value is not yet initialised. This can occur at the restart of the 
RiZone server. 
good(2), – value is OK. 
bad(3), – the value could not be determined (e.g. timeout). These values do 
not represent the current status and cannot be used for calculations. 
 
Variable Value Int  – integer value of the variable (type number or enum) 
Variable Value String  – written out value. For (type = number) the value 
taking account of the factors and a point as decimal separator. For (type = 
enum) the significance of the value, e.g. Int=4 > String="OK". 
Variable Value Unit – measurement unit of the (Int value * 
multiplicand/divisor) e.g. (W, kW, mA, °C) 
Variable Divisor  – divisor of the value (e.g. value = 333 ; divisor = 10 ; unit 
= °C gives 33.3 °C) 
Variable Multiplicand  – multiplicand of the value. 
 
Trap 
The RiZone MIB integrates a “projectUpload” trap. This is sent for each 
upload from a project to the entered trap receiver. The content of the trap 
are variables from the tree listed above – sysContact, sysName, 
sysLocation, riZoneProjectName, riZoneProjectChangeTime. 
 
FAQs 
There is no setting dialogue for the SNMP agent.  
Check your license whether the SNMP agent is activated. 
 
No message arrives in RiZone whether the SNMP agent  has been 
started.  
Activate “Activate SNMP agent”. You must now receive a message in the 
RiZone message list. If not, check whether the Messaging Service is 
running. (As of version 1.3, the Messaging Service is a Windows service.) 
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To activate the OPC-UA interface, select the OPC UA-Agent  tab in the 
Administration > Messaging service  menu. Activate the Activate OPC-
UA-Agent  checkbox to activate the service. 
Activate the Enable OPC-Protocol  checkbox to establish the connection 
using an OPC UA-Server. 
Enter the configuration of the OPC-UA port OPC-Port  in the field. 
 
To login the OPC-UA server to the RiZone OPC-UA client, the user of the 
server must be a member of the RiZone3rdParty  local group. This user 
must be created via the user administration of the operating system.  
Further rights are assigned on the RiZone side. 
 
 

 

Caution! 
A read access to all published 
variables is possible without any 
further rights assignment. 
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28 Update and deinstallation of the RiZone GUI 

28.1 Update of the RiZone GUI 

The RiZone GUI is updated by the deinstallation and the installation of the 
new GUI. 
Detailed information is provided in the Installation and Deinstallation sections 
of the GUI. 
As of RiZone 2.0, an installed Microsoft .Net Framework 4.0 is required for 
the operation. 
The .Net 4.0 download is available at: 
http://www.microsoft.com/download/en/details.aspx?id=17851 

28.2 Deinstallation of the RiZone GUI 

The RiZone GUI is deinstalled locally from the client PC control panel. 
Example Windows 7: The control panel is opened and the P menu item 
selected. Then select the Rittal RiZone GUI  program.  
 

 
Fig. 77 Deinstallation of the RiZone GUI 

 
Click the Deinstall  button to prepare the deinstallation of RiZone.  
 
A deinstallation under Vista or Windows 8 is performed similarly. 
 
Alternatively, the deinstallation or repair of the RiZone GUI can be performed 
via the GUI Setup file (RiZone GUI Setup V3xxx.exe). To do this, start the 
GUI Setup with a double-click on the file in the Windows Explorer. You can 
then select between Repair  and Remove . Follow the instructions on the 
screen. 
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29 Technical specifications 

29.1 Virtual machine (Software Appliance) technical 

specifications 

System requirements*  

CPU 2 GHz dual core processor 

RAM 4 GB 

Hard disk capacity 120 GB 
Network 1 Gbit SNMP 

1 Gbit Fileshare/Management 
File format OVA 
Client operating system Windows Server 2008 R2 64-bit 

Windows Server 2012 R2 64-bit 
Ports used 161 (SNMP get/set), 162 (SNMP trap 

handler), 800 (certificate provider), 
3389 (RDP), 4433 (https for roles 
and rights), 22222 & 22223 (RiZone 
Core service port) 

* The listed system prerequisites apply to the virtual machine. The 
virtualisation environment (hypervisor) must then run on more powerful 
hardware with more CPU power / RAM. 
  

29.2 Hardware Appliance technical specifications 

CPU Xeon Quad Core processor with 3.2 
GHz 

RAM 4 GB 

Hard disk capacity 2 x 500 GB (RAID 1) 
Network 2 x 1 Gbit Ethernet 
Operating system Windows Server 2008 R2 64-bit 

Windows Server 2012 R2 64-bit 
Ports used 161 (SNMP get/set), 162 (SNMP trap 

handler), 800 (certificate provider), 
3389 (RDP), 4433 (https for roles and 
rights), 22222 & 22223 (RiZone Core 
service port) 

 

 

Note! 
The installation of virus scanners on 
both appliances is permitted provided 
the database folder is excluded from 
the scan. 
The installation of a backup client is 
also permitted. 
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29.3 Network ports for the process communication 

 

 
Fig. 78 Used network ports 
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30 GUI  
 

30.1 Project statistics 
The RiZone GUI can display project statistics. This is done from the Edit  
menu item. The report is prepared for the complete RiZone project. 
The following values are displayed: 
 
Variables: Total number of variables in the project 
Variables (published): Published (SNMP) variables 
Variables polled just once:  
Variables with 10 seconds polling interval:  
Variables with 30 seconds polling interval:  
Variables with 300 seconds polling interval:  
Variables with 1800 seconds polling interval:  
IPs: Number of IP nodes in the project 
Structure components: List of all structure component types and their 
amount 
Rittal devices: List of all deployed Rittal device types and their number 
Third-party devices: List of all deployed third-party device types and their 
amount 
Unknown components: Components for which no driver is available 
 

31 Including SNMP third-party devices 
RiZone 3.6 provides several new functions for creating SNMP drivers for 
devices from third-party manufacturers (see Section 7.3). 

31.1 Creating a template for the view 
In administration mode, the Symbol  menu item is selected with a right-click 
on the driver in the SNMP template tree. This allows a standard view to be 
created for this device type. The editor has the same functionality as for 
creating views (Chapter 8). 
As in the normal views editor right-click > Load background  places a 
background image over the complete defined drawing area of the symbol. 
The size of the drawing area must be defined beforehand by specifying the 
height [mm], width [mm] and scale. The side ratio assumes particular 
importance because otherwise the background image becomes distorted. 
The scaling size cannot be altered retrospectively. If the size/scaling is 
incorrect, the symbol or the complete view must first be deleted and then 
recreated. 
Any variables of the device can be represented with the V function in the 
view. Variables can also be placed next to the background by placing them 
outside the drawing area. 
If one or more polygon areas are placed on the background with the polygon 
function, they indicate the device status later during running operation 
(green, yellow, red). 

31.2 Automatic import of status values 
During the creation of a driver in RiZone, the status variables of a device are 
detected automatically provided the translation is made in accordance with 
the schema "Integer { on (0) , off(1) }".  
The status variable must be configured as follows for an automatic 
translation: 
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Display type: String 
Function type: Setting 

31.3 Assigning status designations 
The variable details provide the Translate status  option. Whereby, each 
value of the status variable can be assigned a status (e.g. OK, Warning, 
Alarm). This improves clarity during the subsequent operation because the 
status is displayed in plain text rather than just as a numeric value. 
The translation is defined as a table with the Name and Value columns. The 
translation is activated or deactivated with the associated checkbox. 
The Name column contains the user-defined translation, e.g. on  or off .  
The Value  column contains the values for which the user-defined translation 
should be displayed. 
The names and values must be unique! 
A name may contain only alphabetic characters (A-Z, a-z) and digits (0-9), 
and must begin with an alphabetic character! 
A value may contain only integers and the semicolon delimiter! 

31.4 Validating the SNMP Set command 
When creating the third-party driver, the SNMP Get command that RiZone 
executes automatically after an SNMP Set command can be deactivated. To 
do this, double-click the associated variable to invoke the variable details. 
The Set command is disabled by deactivating the SNMP-Set Test  checkbox. 
 
Components are available on the market that respond only to the edge of 
the SNMP Set command and reset the variable to default automatically. 
RiZone then signals that the SNMP Set command execution failed, even 
though the SNMP Set command was executed successfully. The 
deactivation suppresses this false message. 
 

32 LDAP / Active Directory connection 
In addition to common RiZone users and access users, RiZone can also 
work with domain users from LDAP / Active Directory. To use the domain 
users in RiZone, the RiZone server services must be executed under a 
domain user. This may need to be considered during the installation of the 
server. 

32.1 Adding users from LDAP / Active Directory (AD) 
To add an LDAP/AD user, proceed as follows: 
Administration > User administration > Create/add u ser >  Switch 
combobox Add user from domain > Add  (opens the Windows dialogue 
Select user ) > Enter name > OK > Create/add user 
 
The Add user from domain  combobox is available only when the RiZone 
server services are executed under a domain user. 
 

32.2 Administering LDAP / AD users in RiZone 
Like common RiZone users, users created via LDAP/AD can be assigned 
roles that can also be revoked later. If such a user is deleted, no deletion 
from the domain is performed, but rather all role assignments are revoked. 
When performing a login of the user on the RiZone client, ensure that the 
complete User Principle Name (UPN) is specified. Example: 
max.muster@domaene.de  
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33 Access administration 
As of RiZone version 3.6, the access administration of all Processing Unit III 
systems contained in the project can be configured centrally. The central 
administration greatly simplifies the configuration of the access rights 
compared with the local configuration on each individual Processing Unit. 
RiZone also supports the 4-eyes principle for access control. 
To use the functionality in RiZone, the Processing Units contained in the 
project must use firmware version 3.15.00_3 or later. 

33.1 Importing access users from Processing Units 
If users for access administration have already been created on the 
Processing Units III (PU), they can be imported as access users in RiZone. 
This requires that the following general conditions are satisfied: 

• Access via SFTP must be enabled on all PUs. This is done in the 
device tree with a right-click on PU > Properties . The data in 
accordance with the configuration on the PU must be entered for 
SFTP/SSH User and Password .   

• Import is possible only when none of the users exists already on 
the PU in RiZone. An existing user prevents the complete import. 

• Only the access users and the first PIN / card number are 
imported. No import of any rights configured on the PU is 
performed. 

 
To perform the import, first click Administration > Import access 
administration . 
All PUs of the project are listed in the Import access administration  
window. The PUs whose access users should be imported are selected by 
activating the associated checkbox in front of each line. The checkbox at the 
top left in the window selects all available PUs. 
The dropdown menu in the first line permits the selection between User  and 
Information . The selection specifies whether the user name should be 
fetched from the User field or from the Information field of the PU. If the user 
name is stored on some PUs in the User field and on others in the 
Information field, the import must be performed more than once. 
Click OK to start the import. 
All users on the selected PUs are then created as access users in RiZone 
(observe the general conditions). 

33.2 Reader differentiation 
The handle that each card reader / keypad is permitted to open is specified 
via the reader differentiation. 
To use the reader differentiation, the Enable access configuration  
checkbox must be activated in the properties of the Processing Unit III (PU) 
(device tree, right-click PU > Properties ). The data in accordance with the 
configuration on the PU must also be entered for SFTP/SSH User and 
Password.   
 
To configure the reader differentiation in the device tree, right-click the 
associated PU and select Reader differentiation .  
The window for reader differentiation opens. It contains a matrix with the 
card readers / keypads on the Y-axis and the handles on the X-axis. 
Activating the associated checkbox gives the card reader / keypad access to 
the handle. In addition to the card readers / keypads, the LCPs and universal 
sensors with Wiegand configuration are listed as reader unit. 
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access to all handles. 
The project must then be uploaded to the server via Project > Upload to 
server . This also creates the individual access.cmc3 files for the PUs that 
are distributed via SFTP to the PUs (see also the configuration of the roles 
and rights for access administration). 

 

33.3 Configuration of the roles and rights for access 
administration 

To allow users or access users to open handles, the normal roles and rights 
concept is used in RiZone. 
Consequently, a new role is created first (see Chapter 16). To give the new 
role access to a handle, right-click the desired node in the location tree 
(Handle or Access controller) and select Properties  > Rights . 
Click the Select  button in the access  field to select the role(s). If more than 
one handle should be assigned the same roles, it is better to use a higher 
level structure component (e.g. a room or an enclosure suite) via Properties 
> Rights. If the role is assigned in the access  field and the Include lower-
level components of the location tree  checkbox is activated, the role 
assignment applies to all lower-level handles and access controllers of the 
structure component. 
 
All users or access users who should be authorised must still be assigned 
the new role (see Section 14.4). 
 
The project must then be uploaded to the server via Project > Upload to 
server . This also creates the individual access.cmc3 files for the PUs that 
are distributed via SFTP to the PUs. 
Note that RiZone supports a maximum of 2000 lines in access.cmc3.  

33.4 Using Access Acknowledge (4-eyes principle) 
For the 4-eyes principle, the PINs or keycards must be entered by two users 
in order to open the handle. 
To configure this in RiZone, a role to be determined for this purpose must be 
assigned to the access acknowledge right in the properties of the handle. 
The authorised users for access acknowledge must also be assigned to this 
acknowledge role. 
The project must then be uploaded via Project > Upload to server . 
 
Please note: If the Acknowledge right has been set for a handle, the 
Acknowledge right must also be set for all handles of the same 
Processing Unit. If this is not done, these handles  can no longer be 
opened!  
The behaviour results from the construction of the Processing Unit. 

33.5 Logging accesses 
Accesses to the enclosure via keypads or keycard readers are displayed in a 
new message list. The message list is displayed via the Access messages  
tab in the lower message area of the RiZone GUI. 
The message list can be filtered according to time interval, status, variable 
ID, location and user. 
If one or more Processing Units are not accessible via the network for some 
time, no access messages are displayed for this interval. Consequently, 
once the network connection has been re-established, the message list is 
matched with the local access logging on the PU.  
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Please note: The data in accordance with the configuration must be entered 
on the PUs for SFTP/SSH User and Password. This must be performed in 
the component properties. The name of the component (node) in RiZone 
must also match the Description  on the CMC III component itself. A 
"reorganise" (prior to the configuring in RiZone) on the CMC III component 
can cause values from log files generated prior to the "reorganise" in RiZone 
to be assigned incorrectly.  
 
The matching is made via the time stamp (3-second inaccuracy). 
Consequently, we recommend that RiZone Servers and Processing Units 
use the same NTP server. 

 

34 Database 
The database connection is configured in the Administration > Database  
menu in the RiZone GUI. RiZone supports database version up to Oracle 
12c as well as Microsoft SQL Server 2005, 2008R2 and 2012. 

34.1 Configuring a database backup 
The interval of the database backup can be configured for the SQL Express  
server type. The number of days between the backups can be set in the 
Interval  menu item. The value "0" deactivates the backup. 
After setting the value, the backup is made at 2:00 a.m. on the following day. 
The backup is then performed in accordance with the configured interval. 

34.2 Database diagnostics 
Activating the Activate database diagnostics  checkbox creates 
performance counters that allow Rittal Service to evaluate the speed of the 
database. 
The results file is stored in the following data path: 
<user>\AppData\Roaming\Rittal\RiZone\Data\Diagnostics\*.csv. 
 

35 Offline configuring 
The offline configuring can be used to configure a RiZone project in advance 
(see Section 7.18). The offline configuring does not require an IP connection 
to the CMC III components to be configured. 
The project is created identically as for a normal project. Select the Offline  
tab in the discovery window (Edit > Discovery  menu).  
The Offline  tab shows all CMC III devices and the LCP available for the 
offline configuring. 
No rights assignment is possible for offline configuring. 
 

36 Login mask 

36.1 Password expiration 
An appropriate message will be issued if users with expired password or 
deactivated account attempt to login.  
Local server users can reset their password if it has expired. Domain users 
cannot change their password via RiZone. 
Note: Users are notified seven days prior to expiration of their password 
during the login. 
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37.1 Saving the message list 
The message list can be saved on the client computer using the RiZone GUI 
by opening the Administration > Download messages  menu. The 
following selection window opens: 
 

 
 
 
The date of the log files is selected using the calendar function. The 
category, the message type and the status are selected by activating the 
appropriate checkboxes. 

37.2 Filtering by location 
Two new input fields, ID and Location,  are provided in the Current 
messages  and Access messages  message lists. These are fields with 
autocompletion functionality. 
If the name of an existing variable ID or location is entered, only those 
messages whose owner is assigned below this component in the location 
tree are displayed. 
 

38 Traps 

38.1 Creating traps in the workflow 
The Workflow engine can send user-defined traps with the Send Trap  
FlowElement. 
The traps must be classified into the following categories: 

• NA 
• Info 
• Warning 
• Error 
• OK 

The maximum length of a message text is 256 characters. 
Variables are selected with Variable Binding by moving the component that 
owns the variables into the selection window with drag & drop. The variables 
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are selected from the usual dropdown menu. Only those variables set as 
published can be sent (Variables list > double-click variable > activate 
the Publish checkbox ). 
The target of the traps, the so-called trap receivers, must be entered at 
Administration > Messaging service > Trap receiver 1 & 2. 

38.2 Forwarding traps 
Incoming traps can be forwarded automatically to the set trap receivers.  
The trap of a component is forwarded to the trap receiver set in the 
MessagingService only if the SendTraps  flag is set in the component 
properties. 
The trap is forwarded unchanged and possesses the usual agent address 
(that of the device). 

38.3 Discarding generic traps 
The discarded generic traps (Discard generic traps ) are configured in the 
Properties  window of the component.  
The following traps can be selected. 

• Cold start 
• Warm start 
• Link down 
• Link up 
• Authentication failure 
• EGB neighbour loss 

Multiple components can be selected and the setting made with a 
multiselect. 

38.4 Discarding specific traps 
The discarded specific traps (Discard specific traps ) are configured in the 
Properties  window of the component. A maximum of 32 traps can be 
blocked. The configuration is made via the trap number as specified in the 
documentation or in the MIB of the terminal. 
The number of the specific trap is also shown in the message window when 
the trap details are opened. 

38.5 Discarding unknown traps 
To discard traps unknown to the RiZone project (unknown traps) proceed as 
follows: 
Administration > Communications module configuratio n > activate 
Suppress unknown traps  checkbox. 

38.6 Traps from third-party devices 
Variable Binding supports traps from third-party devices. If a trap is not sent 
standard-conform from the terminal to RiZone, it will be represented as 
information in the message list.  
 

39 Polling interval 
For complex SNMP devices with very many or redundant variables, it may 
be desirable not to poll several variables by RiZone. 
Consequently, it is now possible to set the polling interval of a variable to 
deactivated . This is possible in the Change variable  window (Variables list 
> double-click variable ). The variable is then represented as empty value 
with quality bad . 
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interval must be set to once . This corresponds to the off  configuration of 
earlier RiZone versions. 
 

40 Displaying the SNMP version of the devices 
The SNMP version used for the communication is displayed in the properties 
of a device. The value is updated when the project is uploaded or 
downloaded. 
A search for this property can be made with the search function: 
Edit > Search > Components > Property > SNMP versio n. 
 

41 Address of the SNMP agent 
RiZone can be queried via SNMP from other management systems (Chapter 
27). The IP address with which the external management system accesses 
the SNMP agent is set under Administration > Messaging service > 
SNMP agent > Agent address . As possible options, all IP addresses of the 
RiZone server are displayed or Any .  
The correct selection depends on the individual configuration of the RiZone 
server. If only one IP address is assigned to the server, it does not matter 
whether Any  or the IP address is selected. 
 

42 Extending the search function 
The search function under Edit > Search  has been extended in the 
component search area. 
It is now possible to search for the rights assignments for read, settings, 
configuration, execution, charts, workflow, reports , access and 
acknowledge access . All users assigned at least one role are displayed 
automatically as value . It does not matter whether a RiZone user or a 
domain user is involved. 

 

43 Support for video stream from Axis cameras 
RiZone supports Axis Web cameras via the HTTP protocol (VAPIX V3). The 
discovery is made in the additional HTTP tab in the discovery window. Note 
that during a discovery, either SNMP or HTTP devices can be discovered, 
but not both together. 
The IP area and the password of the camera must be entered. The URL, the 
user name and the port are preconfigured as follows: 
URL: /axis-
cgi/admin/param.cgi?action=list&group=Properties.API.HTTP.Version 
User: root 
Port: 80 
 
The video signal is represented in its own tab in the RiZone GUI main 
window. The videostream is not recorded. The Web cam is not monitored for 
network availability. 
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44 Dynamic Rack Control (DRC) (as of RiZone 
3.6.xx.5) 

 
The DRC integration in RiZone permits an automatic acquisition of all 
components installed in the rack as well as the photo-realistic representation 
of the server racks. The DRC allows the capacity management described in 
Section 15 to be largely automated. 
 

44.1 DRC in the locations tree and in views 

During the project creation, the DRC component must be assigned to a rack 
in the locations tree. As usual, this is done with drag & drop from the 
discovery window to the locations tree. 
When creating the view of this rack, the rack must first be dragged to the 
view drawing area. The DRC component must then be moved also with drag 
& drop from the locations tree to the rack in the drawing area. After saving 
the view and uploading the project to the server, the rack is represented with 
the components identified via the DRC. If no templates are defined, the DRC 
tag components are represented as monochrome area with encryption.  
For a photo-realistic representation, templates for the automatic generation 
of a view on the rack must be created and the DRC component must be 
configured on the rack components in the view.  
 
During the first project start, all available RFID tags are added automatically 
to the RiZone project. If an RFID tag is assigned subsequently to the 
enclosure, it will be transferred automatically to the project. 
 
If a project that contains the DRC is uploaded to the server, the client issues 
a prompt whether the tags should also be displayed in Admin mode. If the 
prompt is confirmed with Yes, the project will be updated in Admin mode and 
all tags recognised by the DRC are displayed in the project trees. If No is 
selected, only the DRC components, but not the individual tags, are still 
displayed in the trees. 
 
During the initial commissioning of the DRC, it must be selected in which 
direction the entries of the RFID tag are synchronised. Possible directions 
are: 
 
DRC -> RiZone: The data on the RFID tags overwrites the data in the 
RiZone enclosure element (more exactly: the existing element is deleted and 
is replaced with the tag). 
 
RiZone -> DRC: The data of the RiZone component overwrites the data on 
the RFID tag. 
 

44.2 Manual confirmation for configuration changes 

If alarms or changes occur in the enclosure, for example those caused by 
adding or removing devices, they will be detected by the RFID system and 
reported to the RiZone. The affected device or its tag is marked red in the 
view of the DRC rack. Like other sensors, these alarms are inherited 
upwards in the infrastructure and are displayed on the higher-level 
infrastructure components. 
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 Fig. 79 Changes for tags in the rack 

 
Such changes must be confirmed by the user in order to signal to the system 
that the changes are authorised. This requires that the associated tag is 
acknowledged. 
Be aware that as long as 30 seconds can elapse between a change being 
made in the enclosure and the signalling in the DRC view. 
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Fig. 80 Acknowledging a change via the context menu - 1 

 
To do this, right-click the tag and select Set value . 
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Fig. 81 Acknowledging a change via the context menu - 2 

Now select Quit  and click Set.  
The acknowledge command is now sent to the appropriate Processing Unit 
and the tag status switches to OK (green). 
 
Alternatively, the tag can also be acknowledged via the variables list of the 
tag.  
 

 

Important! 
If a device, incl. tag, is dragged from 
the enclosure, it will be displayed 
immediately via the message list in 
RiZone. The display of the change in 
the variables list and the values 
history, however, can appear after a 
delay as long as 30 seconds. 
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Fig. 82 Acknowledging via the variables list of the tag 

To do this, the Command  variable must be set to Quit  by clicking the Set 
button. 

44.3 Creating a 19" template 

A 19" template is created in the similar manner as an infrastructure 
component. Folders can be created in the templates tree. This permits a 
hierarchical structure according to manufacturer and type of the 19" 
templates. For the automatic assignment of the template to an RFID tag, the 
component name of the 19" template must match the Manufacturer and 
Type fields of the RFID tag (case insensitive).  
The 19" template, however, can also contain wildcards ("*" or "+"), so that a 
single 19" template can cover different model types. 
 
Examples: 
Template  
Name: Dell Poweredge R7* 
Description: any 
Result: The template is used for all Dell Poweredge servers from the R700 
series (R710, R715, R720, etc.). 
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Name: Dell Poweredge R71+ 
Description: any 
Result: The template is used for all Dell Poweredge servers from the R700 
series whose name begins with R71 followed by a digit or an alphabetic 
character (R710, R715). 
 
For the photo-realistic representation of the 19" template within a rack, a 
graphic must be stored in JPG format. The Height value specifies how many 
height units are required by the 19" template. 
The Weight value is used for the capacity management in order to calculate 
the floor loading of the rack. The Depth and Connection Power values 
complete the properties of a 19" template. 

44.4 Editing a 19" template 

Renaming, copying and deleting is performed similarly as for the functions of 
the locations tree. 
The image assignment when multiselect is used is an exception. The images 
for representing the device in the enclosure may only be assigned 
individually. 

44.5 Exporting a 19" template 

Multiselection is not possible for exporting a 19" template. If several 19" 
templates must be exported together, they must be grouped in a folder and 
this folder then exported. The root node cannot be exported. When exporting 
a 19" template, the Save file dialogue opens in which the user can specify 
the storage location. 19" templates can be exchanged between different 
RiZone servers. 

44.6 Importing a 19" template 

The Open file dialogue opens when a 19" template is imported. The 19" 
templates are imported below the node from which the dialogue was called. 
 

44.7 Rights of the RFID tags 

The rights of a DRC component are inherited to all RFID tags currently 
acquired by the DRC. Further information about the "Rights assignment" 
topic for components is contained in Section 16. 
 
 

45 Passwords of the RiZone services and the server 
key (as of RiZone 3.6.xx.5) 

Several services are executed on the RiZone server that in turn run under 
different users. These users have a default password. To increase the 
security of the server, customised passwords can be assigned to these 
users provided the users have not been created prior to the installation. 

45.1 Passwords of the RiZone services 

The RiZone services are executed on the server under the RiZoneService 
user with a default password. If customised passwords are used for the 
services, they can be changed directly during the installation of the server 
services. If the setup file of the RiZone server (C:\install_rizone\ RiZone 
Server Setup Vxxx.exe file on the RiZone server) is executed, the Installer 
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offers during the setup process the possibility to install and execute RiZone 
services not under the standard user, but rather under a freely chosen user. 
 

 
Fig. 83 Selecting a default or custom user 

 
If, for security reasons, you do not want to use the Default User , then select 
the Custom User  option here and enter the required user. If a domain user 
is to be selected, the RiZone server must be part of the domain.  
 
In the next step, if required, freely-selected passwords can be specified for 
specific services (Custom password ).  
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Fig. 84 Selecting a default or custom password for a services user 

 
If, however, Default password  is selected, the services use the standard 
password. 
 
If a Custom password  is used for the RzGuiUser , it should be noted down 
because it is required for the subsequent client installation. 
 
Another option is the specification of the server key. Its significance is 
described in the following section. 
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45.2 RiZone server key 

All projects created on the server are encrypted with the RiZone server key. 
If a customised server key (not default ) is selected during the installation, 
exported projects can be imported to other servers only when the server key 
of the exporting server is known. 
 
 

 

Important! 
Please note the server key in case you 
need to change it during the 
installation or later. The restoration of 
a project created on this server is not 
possible without the server key. 

If the server key is created after 
creating a project, this project also 
can no longer be executed on this 
server! 

 
 
In addition to the possibility to set the server key during the server 
installation, it can also be changed later via the RiZone client. To do this, call 
the Administration > Change server key  menu item in the client. To 
change the server key, the current server key must also be entered. 
 

 

We strongly recommend that you 
change the server key only during the 
server installation (when increased 
security is required). 

 
 

45.3 Password of the RzGuiUser 

To prevent a login to the server via a non-authorised GUI (client), RiZone 3.6 
has introduced a password for the RzGuiUser service. The RzGuiUser 
service runs on the server and checks the user name and password of the 
RiZone user performing the login.  
 
Important: The RZGuiUser should not be confused with RiZone users who 
have been created with roles and rights in RiZone and who can then login to 
the server via the client.  
 
The password of the RZGuiUser service is specified during the installation of 
the server (see Fig. 84) (default or freely chosen). 
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Fig. 85 Selecting a default or custom password for a services user 

On the client side, the password can either be specified during the client 
installation or changed during operation in the client via Administration > 
Change password for RzGuiUser .  
If you attempt to login with a client with a password that deviates from that 
on the server, the client requests the correct RzGuiUser password 
automatically. 
 
If you want to ensure that you can login to the server from any client (RiZone 
user + password required), always use the "use default password" option for 
the client and server installations or always specify the same customised 
RzGuiUser password on the server and the client.  
A subsequent change of the RZGuiUser password on the server is possible 
via the Windows user administration of the server.  
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46 Changes from earlier RiZone versions  
(as of RiZone 3.6.xx.5) 

46.1 Changed polling behaviour of the CMCIII Processing 

Unit 

The polling behaviour compared with CMCIII-based devices (Processing 
Unit III, LCP CW, DRC) has been optimised. ALL values whose value has 
changed within the last 10 seconds are now transferred to RiZone every 10 
seconds. Changing the polling interval of individual variables of these 
devices via the variable properties is not supported. The interval is always 10 
seconds. 
 
The variable calculation and the trap sending are not affected by this new 
ruling. 
 

46.2 Deleting messages in the message list 

Previously, all logged-in users in view mode could delete messages from the 
message list of the client. With immediate effect, this is possible only when 
the user has RiZoneAdmin rights. 

 

46.3 Maintenance mode during changes to the CMC III PU 

If changes need to be made to the CAN bus (add/remove sensors) or to the 
firmware on the CMC III Processing Unit or products based on them (PDU, 
LCP CW), the Processing Unit must previously be placed in maintenance 
mode (set Service variable  to Maintenance). After the change, the Service 
variable  can be set again to active and so maintenance mode terminated. If 
this is not done, false alarms or incorrect value displays can occur. 
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47 Access administration with one-time PIN and 
emergency PIN 

 
As of version 3.8, RiZone supports access administration by means of a 
one-time PIN and an emergency PIN. 

47.1 Access administration with one-time PIN 

The One-time PIN function allows access to a rack once or for a limited 
period from 1 hour to 36 hours. 
For this purpose, the location tree in the context menu provides the 
Generate one-time PIN  function to generate a PIN that allows the enclosure 
to be opened once or during a specified period.  
A typical application scenario is, for example, opening the enclosure by a 
technician who receives the associated one-time authorisation by telephone 
from the responsible control room.  
 
The prerequisite for the use of the one-time PIN is that the rack is equipped 
with a Rittal access system with the following components: 

•  CMC III Processing Unit with firmware as of 3.15.20_6 
•  CMC III CAN bus access (7030.200) 
•  CMC III coded lock (7030.220) 
•  TS 8 handle with master key function (7320.721) 

 
In RiZone, the handle (or Access Controller) must be assigned correctly to 
the enclosure in the location tree. The keypad has to be part of the project, 
too. For the keypad it does not matter if it is assigned to the enclosure or any 
other infrastructure component. 

   
Fig. 86 Handle rack assignment 

 
Furthermore, the following configurations in the properties of the handle or 
the Access Controller and of the CMC III PU must be made in Admin mode 
for RiZone. Even if the symbol for the Processing Unit is not assigned in the 
location tree, the Processing Unit can always be accessed via the device 
tree. 
 

1. SFTP/SSH configuration  
The port, user and password for the SFTP/SSH access must be 
entered in the properties of the CMC III PU to which the Access 
System is connected. By default, these are the values: Port=22, 
User=admin, Password=admin. Click Accept  to confirm the change. 
We recommend that at least the password on the CMC III PU is 
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changed. This requires that the new password must also be entered 
in RiZone. 
RiZone then transfers the one-time PIN via SFTP to the associated 
CMC III PU later. 

2. Enable access configuration 
The Enable access configuration  option must be activated in the 
properties of the CMC III PU to which the Access System is 
connected. Click Accept  to confirm the change. 
Note that when uploading the project for activated Enable access 
configuration , the access administration file for RiZone is 
transferred to the CMC III PU. RiZone must now handle the access 
administration, at the latest. 

3. Enable one-time PIN  
The Enable one-time PIN  option must be activated in the properties 
of the Access Controller or handle to be opened later. Click Accept  
to confirm the change. 

 
The updated RiZone project must then be uploaded via Project > Upload to 
server . 
 
In the RiZone View mode, the Generate one-time PIN  function can now be 
called by right-clicking the associated rack in the location tree. 
 

 
Fig. 87 "Set one-time PIN" dialogue 

 
RiZone generates the 6-character PIN using a random function. 
The validity of the PIN is defined via the Validity duration  dropdown menu. 
One-time : The PIN is discarded immediately after its one-time use for 
opening the rack. 
1 h – 36 h : The PIN can be used for the specified time interval to open the 
rack. 
 
Clicking Set transfers the PIN with the set validity duration to the CMC III PU 
via SFTP. The successful transfer is confirmed with the PIN set successfully 
message. 
The rack can then be opened by entering the one-time PIN on the keycode 
reader. 
A failed transfer is signalled with the PIN could not be set message. In this 
case, check the above-mentioned settings and also the SFTP settings on 
the CMC III PU. 
 
After opening the rack with the one-time PIN (or after expiration of its validity 
duration), the one-time PIN on the CMC III PU is deleted automatically. 
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47.2 Access administration with emergency PIN 

The 8-character emergency PIN has a similar behaviour as the one-time 
PIN. The emergency PIN, however, remains valid until it is replaced by the 
user via RiZone with a new emergency PIN. 
An emergency PIN and a one-time PIN can also be used in parallel on a PU 
III or a handle. 
A typical application scenario, for example, is to note the emergency PIN 
after transfer to the CMC III PU and to store this document securely for 
emergencies (e.g. in a safe). 
 
The prerequisite for the use of the emergency PIN is that the rack is 
equipped with a Rittal access system that has the following components: 

•  CMC III Processing Unit with firmware as of 3.15.20_6 
•  CMC III CAN bus access (7030.200) 
•  CMC III coded lock (7030.220) 
•  TS 8 handle with master key function (7320.721) 

 
In RiZone, the handle (or Access Controller) must be assigned correctly to 
the enclosure in the location tree. 

   
Fig. 88 Handle rack assignment 

 
Furthermore, the following configurations in the properties of the handle or 
the Access Controller and of the CMC III PU must be made in Admin mode 
for RiZone. Even if the symbol for the Processing Unit is not assigned in the 
location tree, the Processing Unit can always be accessed via the device 
tree. 
 

1. SFTP/SSH configuration  
The port, user and password for the SFTP/SSH access must be 
entered in the properties of the CMC III PU to which the Access 
System is connected. By default, these are the values: Port=22, 
User=admin, Password=admin. Click Accept  to confirm the change. 
We recommend that at least the password on the CMC III PU is 
changed. This requires that the new password must also be entered 
in RiZone. 
RiZone then transfers the emergency PIN via SFTP to the 
associated CMC III PU later. 
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2. Enable access configuration 
The Enable access configuration  option must be activated in the 
properties of the CMC III PU to which the Access System is 
connected. Click Accept  to confirm the change. 

3. Enable emergency PIN  
The Enable emergency PIN  option must be activated in the 
properties of the Access Controller or handle to be opened later. 
Click Accept  to confirm the change. 

 
The updated RiZone project must then be uploaded via Project > Upload to 
server . 
 
In the RiZone View mode, the Generate emergency PIN  function can now 
be called by right-clicking the associated rack or a higher-level node in the 
location tree. If an emergency PIN is activated on a higher-level node, this 
PIN is used for all handles subordinate to this node. 
 

 
Fig. 89 "Set emergency PIN" dialogue 

RiZone generates the 8-character emergency PIN using a random function. 
 
Clicking Set transfers the emergency PIN to the CMC III PU via SFTP. The 
successful transfer is confirmed with the PIN set successfully message. 
The rack can then be opened by entering the emergency PIN on the 
keycode reader. 
The rack can now be opened any number of times with the emergency PIN. 
Although the emergency PIN does not expire, it can be overwritten with a 
new emergency PIN. 
 
 

 

Caution! 
After transferring to the CMC III PU and 
closing the "Set emergency PIN" 
dialogue, this PIN can no longer be 
displayed by RiZone. The emergency 
PIN is then stored encrypted on the 
CMC III PU and can no longer be 
fetched. Consequently, note the 
emergency PIN and store the 
document at a secure location.  
The current emergency PIN can be 
overwritten only by generating a new 
emergency PIN. 
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47.3 Search for access authorisations 
RiZone supports the search for card numbers and PINs in the access 
authorisation. 
The access authorisations are configured via Administration > User 
administration > User > Administer access authorisations . 
 
The search provides a text field for the PINs and card numbers. The search 
is activated when one of the text fields is filled. 
 
The filter text may contain all characters. 

• One or more digits at the start of the filter text mean that the sought 
PIN or card number begins with these digits. 

• One or more digits at the end of the filter text mean that the sought PIN 
or card number ends with these digits. 

• The * character can represent any character string (wildcard). 
• The + character represents just one arbitrary character. 

 
If an invalid character string is entered in the filter text field, the input field 
receives a red frame and Unallowed characters in filter text is displayed as 
tooltip. 
 
The filter function so makes it easy to determine whether a PIN or card 
number is assigned to the user. 
 

48 Firmware update 
 
RiZone supports a central firmware management of the CMC III PU. The 
transfer of the firmware file to the PU requires that the PU is integrated in the 
RiZone project. If the CMC III PU has been rediscovered, the project must 
first be uploaded before this PU can be updated. The SFTP/SSH user must 
be specified in the PU properties, the password entered, and the project 
then uploaded.  
Once RiZone has loaded the file to the CMC III PU, the PU checks the 
update file before performing the update. In the event of an incorrect update, 
the CMC is restarted automatically after approximately 5 minutes, and the 
last operational firmware and configuration restored. 
The RiZone update function allows different versions of the PU firmware to 
be updated to a new version in a single work step. 
 
To perform the CMC III PU firmware update from RiZone, proceed as 
follows: 
1. Firmware update  menu 

The GUI must be in Admin mode. Open the function via Administration 
> Firmware update . 

2. Select the firmware file  
After selecting the Firmware update  menu item, the Open file  dialogue 
opens. The firmware file must be selected and opened with a double-
click or by clicking the Open  button. 

3. Select the CMC III PU devices  
The Update menu lists all available PUs. 
The checkbox in front of each PU can be activated to select the 
associated PU for the update process. Activating the higher-level 
checkbox selects all PUs. 
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Clicking Update  in the dialogue initiates the update process. RiZone 
transfers the firmware file with the SFTP protocol to the PU. Clicking 
Cancel  cancels the update process immediately.  
Any previously initiated SFTP transfers and updates will be performed. 
The current status is displayed in the Status column of the menu: 
Upload the firmware : The firmware file is uploaded to the PU 
Update being performed : The PU is being updated. 
Successful : The PU update was successful. 
Error : The PU update failed. 
Cancelled : The update operation was cancelled. 
Wait for restart : The update has been performed, RiZone is waiting for 
the PU restart to complete. 

5. Behaviour in the event of an error  
If an error occurred during the PU update, this error will be logged in the 
message list (failure). 

 

49 Eventlog 
The RiZone services log the Start, Stop, ConnectToCore, 
LostConnectionToCore and ProjectLoaded status information in the 
Eventlog of the RiZone server operating system. 
The following RiZone services write to the Windows Log or to the Application 
Eventlog: 
CoreService, MessagingService, MonitoringModule, ReportingService, 
WorkflowService, CommunicationService, CalculationEngine, 
SecurityService, ProjectModifierService, ProxyService, ConfigurationModule. 
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